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About TIMS Medical & Foresight Imaging LLC  

 

TIMS Medical is a division of Foresight Imaging LLC focused on finished medical devices for the 

recording, editing, archiving, and real-time collaboration on medical imaging studies.  Applications 

include modified barium swallow studies, FEES, endoscopy, interventional radiology, ultrasound, 

surgery, DICOM & PACS/VNA connectivity, and much more.  Over 5000 systems are installed in 

hospitals, imaging centers, and medical schools worldwide.  For further information, visit 

www.tims.com or email info@tims.com.  

Foresight Imaging LLC is a world leader in the design of high accuracy, high performance video 

streamers, frame grabbers, & medical imaging hardware and software.  Foresight Imaging video 

acquisition boards are the imaging engines of many finished medical devices and military imaging 

systems in use throughout the world. The company is certified to the ISO 13485 quality standard.  

Auto-SYNC, IDEA, AccuStream, AccuStream Express, TDRS, and the PACS Connectivity Solution are 

trademarks of Foresight Imaging, LLC.  Foresight Imaging, TIMS Connect, TIMS Medical, TIMS MVP, 

TIMS Review, TIMS Medical Video Platform, TIMS DICOM, TIMS Mobile, TIMS Mobile DICOM, TIMS 

Mobile Consultant, and TIMS Consultant are registered trademarks of Foresight Imaging, LLC.  All 

other products and brand names are trademarks or registered trademarks of their respective 

holders. All specifications are subject to change. 

The information in this document has been carefully checked and is believed to be accurate. 

However, Foresight Imaging assumes no responsibility for inaccuracies. All specifications are subject 

to change without notice. 

https://nam12.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww.tims.com%2F&data=04%7C01%7C%7C2b916176518741598e1808da0c4d1b18%7C84df9e7fe9f640afb435aaaaaaaaaaaa%7C1%7C0%7C637835822828264904%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000&sdata=2OmDECRUuyPM%2BVdDcC6X7UgEef4caFw7LIajdNQliXE%3D&reserved=0
mailto:info@tims.com
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Regulatory Information 
 

 

  

 

 

 

 

 

          

 

Conforms with ANSI/AAMI ES60601-1, CAN/CSA-C22.2 No. 60601-1, FCC Part 15 Class A 

Refer to ANSI/AAMI ES60601-1 for requirements applicable to the TIMS MVP system. 

 

Intended Use 

There are no known contraindications to use of the TIMS MVP System.  
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Explanation of Symbols 

Symbol Explanation 

 

Manufacturer 

 

European Authorized Representative 

 

Serial Number 

 

Date of Manufacture 

 

Caution, Consult Accompanying Documents 

 

Catalogue Number 

 

Caution 

 

Temperature Operation Limitations 

 

Humidity Operation Limitations 

 

Atmospheric Pressure Operations Limitations 

 
Alternate Current (AC) 

 
Direct Current (DC) 

 

Antenna 

 

Standby Switch 
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Handling the Medical Equipment 

 Warning:   

Use proper hygiene when using the TIMS MVP System within the patient 

environment.   

Please ensure that your medical facility is in strict compliance and adherence to all 

applicable laws and regulations regarding the handling of electronic equipment with 

respect to cleanliness, disinfection and sterile environments and all other use and 

care instructions when operating this equipment within the patient environment. 

To avoid electrical shock, this equipment must only be connected to a supply main 

with protective earth. 

Do not position unit such that it is difficult to disconnect the device. 

Environmental 

 

Temperature, Operating: 

Storage:  

10° to 40° C 

-40° to +70° C 

 

Relative Humidity, Operating: 

Storage Humidity: 

30 to 75% rH 

10 to 95% rH 

 

Atmospheric pressure, Operating: 

Storage:    

700 to 1060 hPa 

500 to 1060 hPa 

Standby button operation should be pressed for < 1 second. 

Power Supply  

 Warning: 

The Power Supply (MeanWell model GSM120A12-R7B) 

shipped with the TIMS MVP System is a medical grade power 

supply and is the only power supply to be used with the TIMS 

MVP System computer.  Do not use any other power supply 

with the TIMS MVP System as this may result in unsafe 

operation. 

 
Input voltage rating of 100/240Vac, 50/60 Hz, 1.4-0.7A  
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Servicing Equipment 

 Warning:  No user serviceable parts.  

   No modification of this equipment is allowed. 

Electromagnetic Compatibility (EMC) 

This device has been tested for compliance with the EMC requirements. The guidelines in this 

section will help you to make sure that your medical equipment will meet the requirements of the 

standard. 

 

Warning: Medical equipment should not be used, stacked, or located on or around 

equipment that may create electromagnetic inferences. 

Cables and Accessories 

Use of all included cables and accessories is required for proper use of this equipment. Any cable or 

accessory not released with the device may compromise safety and performance. 

Any cable included or provided by TIMS is the proper and required length needed to operate the 

equipment.  

Replacement parts, such as cables and accessories, must be purchased through TIMS to ensure 

proper compliance requirements. 

 

Warning: Using other manufacturer’s cables and accessories may affect EMC and 

product performance. Unauthorized use of these items will void warranty 

and may cause injury harm to you, others and/or the equipment. 

Emissions 

This equipment does not contain any RF communications equipment. 

Note: Mobile RF communications equipment can affect medical electrical equipment. 

 

Failure to use this equipment in the specified type of shielded location could result in degradation of 

the performance of this equipment, interference with other equipment or interference with radio 

services”. 
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Product Disposal Information 

This product should not be disposed of with household waste. It should be deposited at an 

appropriate facility to enable recovery and recycling. 

Table 1 – Guidance and MANUFACTURER’S declaration – 

ELECTROMAGNETIC EMISSIONS – for all ME EQUIPMENT and ME 

SYSTEMS  

Guidance and manufacturer’s declaration - electromagnetic emissions 

The TIMS MVP System needs special precautions regarding EMC (Electro Magnetic 

Compatibility) and needs to be installed and put into service according to the EMC 

information provided in this manual. 

When TIMS MVP System is exposed to electromagnetic (EM) disturbances, the system 

may show abnormal behavior. For instance, the measured traces may be become 

obscured, the software may crash or, in case of very high-level transient voltage events 

like for instance ESD, parts of the system may even become defective. 

Emissions test Compliance Electromagnetic environment — guidance 

RF emissions 
 

CISPR 11 

Group 1 The TIMS MVP System uses RF energy only 
for its internal function. Therefore, its RF 
emissions are very low and are not likely to 
cause any interference in nearby electronic 
equipment. 

RF emissions 
 

CISPR 11 

Class A The EMISSIONS characteristics of the TIMS 
MVP System make it suitable for Class A use 
in industrial areas and hospitals. 

(CISPR 11 class A). If it is used in a residential 
environment (for which CISPR 11 class B is 
normally required) this equipment might not 
offer adequate protection to radio-
frequency communication services. The user 
might need to take mitigation measures, 
such as relocating or re-orienting the 
equipment. 

Harmonic emissions 
 

IEC 61000-3-2 

Class A 

Voltage fluctuations/ 
flicker emissions 
 

IEC 61000-3-3 

Complies 
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Table 2 – Guidance and MANUFACTURER’S declaration – 

electromagnetic IMMUNITY – for all ME EQUIPMENT and ME 

SYSTEMS 

(see 5.2.2.1 f) 

Guidance and manufacturer’s declaration — electromagnetic immunity 

The TIMS MVP System is intended for use in the electromagnetic environment specified 
below. The customer or the user of the TIMS MVP System should assure that it is used 
in such an environment. 

When the TIMS MVP System is exposed to electromagnetic (EM) disturbances, the 
system may show abnormal behavior. For instance, the measured traces may be 
become obscured, the software may crash or, in case of very high-level transient 
voltage events like for instance ESD, parts of the system may even become defective. 

Immunity test IEC 60601 test 
level 

Compliance level Electromagnetic 
environment - guidance 

Electrostatic
  

discharge (ESD) 

IEC 61000-4-2 

±8 kV contact 

±15 kV air 

±8 kV contact 

±15 kV air 

Floors should be wood, 
concrete or ceramic tile. If 
floors are covered with 
synthetic material, the 
relative humidity should be 
at least 30%. 

Electrical fast
  

transient/burst
  

IEC 61000-4-4 

±1 kV for 
input/output lines  

±2 kV for AC and 
DC powerlines 

±1 kV for 
input/output 
lines  

±2 kV for AC and 
DC powerlines 

Mains power quality should 
be that of a typical 
commercial or hospital 
environment. 

Surge  

IEC 61000-4-5 

±1 differential 
mode 

±2 kV common 
mode 

±1 differential 
mode 

±2 kV common 
mode 

Mains power quality should 
be that of a typical 
commercial or hospital 
environment. 

Voltage dips, 
short 
interruptions 
and voltage 
variations on 
power supply 
input lines 

IEC 61000-4-11 

0 % UT 

(100 % dip in UT) 
for 0,5 cycle at 
0°,45°,90°,135°1

80°,225°,270° 
and 315° 

70% UT          
(30% dip in UT) 
for 25 cycles 

70% UT 
(30% dip in UT for 
25 cycles) 

0 % UT 

(100 % dip in UT) 
for 0,5 cycle at 
0°,45°,90°,135°1

80°,225°,270° 
and 315° 

70% UT          
(30% dip in UT) 
for 25 cycles 

0% UT 
(100% dip in UT 
for 5 sec) 

Mains power quality should 
be that of a typical 
commercial or hospital 
environment, If the user of 
the TIMS MVP System 
requires continued 
operation during power 
mains interruptions, it is 
recommended that the 
TIMS MVP System be 
powered from an 
uninterruptible power 
supply or a battery. 
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0% UT 

(100% dip in UT 
for 5 sec) 
 

Power 
frequency
  

(50/60 Hz) 
magnetic field  

IEC 61000-4-8 

3 A/m 3 A/m Power frequency magnetic 
fields should be at levels 
characteristic of a typical 
location in a typical 
commercial or hospital 
environment. 

NOTE  UT is the a.c. mains voltage prior to application of the test level. 
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Table 4 – Guidance and MANUFACTURER’S declaration – 

electromagnetic IMMUNITY – for ME EQUIPMENT and ME SYSTEMS 

that are not LIFE-SUPPORTING 

(see 5.2.2.2) 

Guidance and manufacturer’s declaration — electromagnetic immunity 

The TIMS MVP System is intended for use in the electromagnetic environment specified below. The 
customer or the user of the TIMS MVP System should assure that it is used in such an environment. 

When the TIMS MVP System is exposed to electromagnetic (EM) disturbances, the system may show 
abnormal behavior. For instance, the measured traces may become obscured, the software may crash 
or, in case of very high-level transient voltage events like for instance ESD, parts of the system may 
even become defective. 

Immunity test 
IEC 60601 test 
level 

Compliance level Electromagnetic environment — guidance 

    
 

 

 

 

Portable and mobile RF communications 
equipment should be used no closer to any 
part of the TIMS MVP System, including 
cables, than the recommended separation 
distance calculated from the equation 
applicable to the frequency of the 
transmitter.  

Recommended separation distance 

Conducted RF  

IEC61000-4-6 

3 Vrms  

150 kHz to 80 MHz 

3 Vrms 

 

 

 

 

Radiated RF  

IEC 61000-4-3 

6 Vrms for ISM 
bands 

3 V/m 
80 MHz to 2.7 GHz 

27 V/m 
385 MHz 

28 V/m 
450 MHz 

9 V/m 
710/745/780 MHz 

28 V/m 
810/870/930 MHz 

28 V/m 
1720/1845/1970 
MHz 

28 V/m 
2450 MHz 

9 V/m 
5240/5500/5785 
MHz 

 

 

3 V/m 

  80 MHz to 800 MHz  

  800 MHz to 2,7 GHz  

where P is the maximum output power rating 
of the transmitter in watts (W) according to 
the transmitter manufacturer and d is the 
recommended separation distance in metres 
(m). 

The TIMS MVP System is fairly sensitive to 
conducted and radiated RF. Disturbance of the 
TIMS MVP System trace is possible at and 
below the specified test level. It may be 
necessary to relocate the TIMS MVP System or 
to apply shielding. 

Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site survey,a 
should be less than the compliance level in 
each frequency range.b 

Interference may occur in the vicinity of 

equipment marked with the following symbol: 

  

    
 

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 



 

TIMS MVP Setup and Configuration Guide               xi 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is 
affected by absorption and reflection from structures, objects and people. 

a 
Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio 

broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an 

electromagnetic site survey should be considered. If the measured field strength in the location in which the TIMS MVP System is used exceeds the applicable RF 

compliance level above, the TIMS MVP System should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, 

such as reorienting or relocating the TIMS MVP System. 

b  Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 
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Table 6 – Recommended separation distances between portable 

and mobile RF communications equipment and the ME 

EQUIPMENT or ME SYSTEM – for ME EQUIPMENT and ME SYSTEMS 

that are not LIFE-SUPPORTING 

(see 5.2.2.2) 

Recommended separation distances between portable and mobile RF communications 

equipment and the TIMS MVP System 

The TIMS MVP System is intended for use in an electromagnetic environment in which radiated 
RF disturbances are controlled. The customer or the user of the TIMS MVP System can help 
prevent electromagnetic interference by maintaining a minimum distance between portable 
and mobile RF communications equipment (transmitters) and the TIMS MVP System as 
recommended below, according to the maximum output power of the communications 
equipment. 

 WARNING: Portable RF communications equipment (including peripherals such as 
antenna cables and external antennas) should be used no closer than 30 cm (12 inches) to any 
part of the TIMS MVP System, including cables specified by the manufacturer. Otherwise, 
degradation of the performance of this equipment could result. 

Rated maximum 

output power of 

transmitter W 

Separation distance according to frequency of transmitter m 

150 kHz to 80 MHz  

 

80 MHz to 800 MHz 

 

800 MHz to 2,5 GHz 

 

0,01 0.12 0.12 0.23 

0,1 0,37 0,37 0,74 

1 1,17 1,17 2,33 

10 3,70 3,70 7,37 

100 11,70 11,70 23,30 

For transmitters rated at a maximum output power not listed above, the recommended 
separation distance d in meters (m) can be estimated using the equation applicable to the 
frequency of the transmitter, where P is the maximum output power rating of the transmitter in 
watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected 
by absorption and reflection from structures, objects and people. 
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FCC Compliance Information 

 

 

 

FCC NOTICE 

WARNING  

Changes or modifications to this unit not expressly approved by the party responsible for 

compliance could void the user’s authority to operate this equipment. 

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital 

device, pursuant to Part 15 of the FCC rules. The limits are designed to provide reasonable 

protection against harmful interference when the equipment is operated in a commercial 

environment. This equipment generates, uses, and can radiate radio frequency energy and, if not 

installed and used in accordance with the instruction manual, may cause harmful interference to 

radio communications. Operation of this equipment in a residential area is likely to cause harmful 

interference in which case the user will be required to correct the interference at his/her own 

expense. 

Users should periodically inspect the TIMS MVP System for signs of worn or frayed cables.  If worn 

or frayed cables are found, contact technical support immediately.  Also, periodically inspect the 

TIMS MVP System cable connections to ensure that all cables are securely attached.   

There are no user replaceable or serviceable parts in the TIMS MVP System.  Please contact 

technical support with any questions. 
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Preface  

The TIMS MVP User’s Guide consists of two parts:  

• This TIMS MVP Setup and Configuration Guide provides hardware setup and software 
configuration information for IT & biomedical engineering professionals.  

• The TIMS MVP Operator’s Guide provides technicians and medical professionals 
instructions to work with the TIMS MVP System in everyday operational use.  

What Is TIMS MVP?  

TIMS MVP is an integrated hardware/software system powered by the TIMS Medical Video Platform 

(MVP), a software architecture upon which all TIMS MVP medical products are built for delivering 

high-performance medical video applications.  TIMS MVP provides recording, editing, labeling, 

review, analysis, and archiving of medical video throughout the healthcare enterprise.  This includes 

fluoroscopy, endoscopy, cardiology, angiography, ultrasound, surgical video, and any other medical 

video modality.  All studies can be archived to PACS/VNA in DICOM format and exported as DICOM 

or MP4 video for sharing, distribution, and integration into reports and presentations.  Any DICOM 

study can be imported into TIMS MVP for full use within the system. 

What Is IDEA Auto-SYNC?  

IDEA Auto-SYNC is an application that enables you to optimize the performance of TIMS MVP with 

your modalities. Although TIMS MVP provides predefined common hardware profiles (CHP) files for 

its Foresight Imaging video capture boards, you are always recommended to create your own 

customized CHP files. You do this using Auto-SYNC. 

About This User’s Guide  

The content of this user’s guide may differ in some respects from the functionality of your TIMS 

MVP. Your system’s appearance, hardware configuration, and the layout of your PC and modality 

connections may not be exactly the same as described and depicted in this guide.  

In addition, some of the functionality described in this guide depends on which TIMS MVP product 

configuration you are using. See next page and margin notes throughout this guide.  

This user’s guide describes hardware setup and configuration for the TIMS 2000 and TIMS 2000 SP. 

Some features are not present on TIMS 500 and TIMS Review. See TIMS System Product Line and 

margin notes throughout this guide.  
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Consult the TIMS MVP Release Notes  

Latest details about what is new or different in the current TIMS MVP release are contained in the 
Release Notes.  

Open the Release Notes from the Start menu > TIMS MVP > TIMS MVP Release Notes. 
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TIMS Product Line  
This user’s guide describes the full range of functionality available with the following TIMS MVP 

configurations:  TIMS 500 S, TIMS 2000 EN, TIMS 2000 SP, TIMS 2000 FEES, TIMS Review, and TIMS 

Connect. The key differences are bolded in the following summary. Where functionality is not 

applicable to all versions, the applicable product version is noted in the margin (left).  

TIMS 500 S 

✓ Static capture only 

✓ For endoscopy and surgical modalities  

✓ DICOM send and DICOM receive 

✓ Extensive review, editing, labeling, and analysis tools 

✓ Foresight Imaging video capture hardware  

✓ Small footprint computer 

✓ Support and maintenance (1 year)  

✓ LCD monitor and typical onsite installation 

TIMS 2000 EN 

✓ Static & streaming capture 

✓ For endoscopy and surgical modalities  

✓ DICOM send and DICOM receive 

✓ Extensive review, editing, labeling, and analysis tools 

✓ Foresight Imaging video capture hardware  

✓ Small footprint computer 

✓ Support and maintenance (1 year)  

✓ LCD monitor and typical onsite installation  
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TIMS 2000 SP 

✓ Synched audio 

✓ Static & streaming capture 

✓ For fluoroscopy modalities  

✓ DICOM send and DICOM receive 

✓ Extensive review, editing, labeling, and analysis tools 

✓ Foresight Imaging video capture hardware  

✓ Small footprint computer 

✓ Support and maintenance (1 year)  

✓ LCD monitor and typical onsite installation 

TIMS 2000 FEES 

✓ Synched audio 

✓ Static & streaming capture 

✓ For FEES (Fiberoptic Endoscopic Evaluation of Swallowing) modalities  

✓ DICOM send and DICOM receive 

✓ Extensive review, editing, labeling, and analysis tools 

✓ Foresight Imaging video capture hardware  

✓ Small footprint computer 

✓ Support and maintenance (1 year)  

✓ LCD monitor and typical onsite installation 

TIMS Review 

✓ DICOM send and DICOM receive 

✓ Extensive review, editing, labeling, and analysis tools 

✓ Computer not included 

TIMS Connect 

✓ Optional add-on software to any TIMS video capture station 

✓ Streams TIMS application including live modality video to TIMS Review system for 

real-time collaboration 

✓ Two-way webcam streaming 

✓ Two-way audio 

✓ Chat  



 

xviii                                                                                                                      TIMS MVP Setup and Configuration Guide 

Table of Contents 
Regulatory Information ............................................................................................................... iii 

Intended Use ..................................................................................................................................... iii 

Explanation of Symbols ..................................................................................................................... iv 

Handling the Medical Equipment ....................................................................................................... v 

Environmental .................................................................................................................................... v 

Power Supply ...................................................................................................................................... v 

Servicing Equipment .......................................................................................................................... vi 

Electromagnetic Compatibility (EMC) ............................................................................................... vi 

Cables and Accessories ...................................................................................................................... vi 

Emissions ........................................................................................................................................... vi 

Product Disposal Information........................................................................................................... vii 

FCC Compliance Information ........................................................................................................... xiii 

Preface ..................................................................................................................................... xiv 

What Is TIMS MVP? ......................................................................................................................... xiv 

What Is IDEA Auto-SYNC? ................................................................................................................ xiv 

About This User’s Guide .................................................................................................................. xiv 

Consult the TIMS MVP Release Notes .............................................................................................. xv 

TIMS Product Line ..................................................................................................................... xvi 

Table of Contents .................................................................................................................... xviii 

Glossary of Acronyms .................................................................................................................... xxiv 

Get Connected ............................................................................................................................ 1 

Site Survey ....................................................................................................................................... 1 

Typical TIMS MVP System Installation .............................................................................................. 2 

TIMS MVP System Checklist .......................................................................................................2 

Typical System Unit ....................................................................................................................... 4 

Front View (Front Panel) ............................................................................................................4 

Rear View (Backplane) ............................................................................................................5 

Indicate PC Connections .................................................................................................................... 5 

Power Supply Connection ................................................................................................................. 6 

Power Supply Connection ................................................................................................................. 7 

Modality Connections ....................................................................................................................... 7 

To Make Modality Connections .................................................................................................... 7 

Connecting Your Video Source to AccuStream HD+........................................................................ 11 

DVI-IN Video Sources .................................................................................................................. 11 

Optional Trigger ...................................................................................................................... 12 

S-Video (Y/C) Color Video Sources or Composite Color Video .................................................... 12 

Optional Trigger ...................................................................................................................... 13 

HDMI Video Sources .................................................................................................................... 13 



 

TIMS MVP Setup and Configuration Guide               xix 

Optional Trigger ...................................................................................................................... 13 

Triggers ............................................................................................................................................ 13 

FI Video Splitter Isolator .................................................................................................................. 14 

Network Setup ................................................................................................................................. 15 

Set Computer Name, Domain/Workgroup ................................................................................. 15 

If Static IP Address Is Required .................................................................................................... 16 

Verifying Audio ................................................................................................................................ 18 

Verify the Speaker Setup ............................................................................................................. 21 

Test Your Microphone and Speakers for Use with TIMS MVP .................................................... 21 

Getting Started .......................................................................................................................... 27 

Configuring Channels ....................................................................................................................... 27 

Configuring Channel Settings ...................................................................................................... 27 

Add a New Channel ................................................................................................................. 28 

Delete a Channel ..................................................................................................................... 34 

Edit a Channel ......................................................................................................................... 35 

Duplicate a Channel to Create a New Channel ....................................................................... 36 

Rename a Channel .................................................................................................................. 37 

DICOM Class Customization ........................................................................................................ 38 

Configure the TIMS MVP Worklist ................................................................................................... 42 

Configuring Worklist Settings ...................................................................................................... 43 

Auto-hide PHI .......................................................................................................................... 43 

Open to Worklist ..................................................................................................................... 43 

Override the Application Entity Title ...................................................................................... 44 

Remove the AE Title Override ................................................................................................. 45 

Add Worklist Local Settings .................................................................................................... 46 

Add a Worklist ............................................................................................................................. 48 

Delete a Worklist ......................................................................................................................... 50 

Edit a Worklist ............................................................................................................................. 51 

Duplicate a Worklist .................................................................................................................... 52 

Configuring DICOM Destinations ..................................................................................................... 54 

Configuring DICOM Server Settings ............................................................................................ 54 

Override the Application Entity Title ...................................................................................... 55 

Remove the AE Title Override ................................................................................................. 57 

Add DICOM Server Local Settings ........................................................................................... 57 

Add a DICOM Send Server ........................................................................................................... 58 

Edit a DICOM Server .................................................................................................................... 63 

Delete a DICOM Server................................................................................................................ 65 

Duplicate the Settings for a DICOM Server ................................................................................. 66 

Configuring DICOM Query/Retrieve ................................................................................................ 67 

Enable Query/Retrieve ................................................................................................................ 68 

Add a DICOM Query/Retrieve Server .......................................................................................... 69 



 

xx                                                                                                                      TIMS MVP Setup and Configuration Guide 

Edit a DICOM Query/Retrieve Server .......................................................................................... 70 

Delete a DICOM Query/Retrieve Server ...................................................................................... 72 

Duplicate the Settings for a DICOM Query/Retrieve Server ....................................................... 72 

Advanced Settings ..................................................................................................................... 74 

Labels for Series Description Tags ................................................................................................... 74 

Add a Series Description Name and Label .................................................................................. 75 

Edit a Label .................................................................................................................................. 78 

Delete a Label .............................................................................................................................. 79 

Duplicate a Label ......................................................................................................................... 81 

Windows Active Directory ............................................................................................................... 82 

System Requirements for TIMS Review ...................................................................................... 82 

Configuring the Active Directory Server ...................................................................................... 82 

Access Active Directory TIMS MVP configuration page .............................................................. 83 

Configuring Active Directory ....................................................................................................... 84 

Active Directory Tests for Admin and User Groups ................................................................ 85 

Configuring Security ................................................................................................................... 87 

Change the Administrator Password........................................................................................... 87 

Set the Admin Password ............................................................................................................. 87 

Configuring the Study Lists .............................................................................................................. 89 

Select Fields for the Study Dashboard ........................................................................................ 89 

Purging Old Studies ..................................................................................................................... 91 

Changing the TIMS MVP Studies Directory ................................................................................. 92 

Import and Export TIMS MVP Configuration File ............................................................................ 93 

Export Configuration ................................................................................................................... 93 

Import Configuration ................................................................................................................... 94 

Retain Worklist UID Received from MVP ........................................................................................ 95 

Migrate TIMS3 Config ...................................................................................................................... 96 

Export TIMS MVP Current Settings ............................................................................................. 96 

Migrate TIMS3 Settings ............................................................................................................... 97 

Select Region for Date and Time Settings ..................................................................................... 100 

Creating a Custom Hardware Profile ......................................................................................... 102 

Using IDEA Auto-SYNC ................................................................................................................... 102 

Image Requirements ..................................................................................................................... 102 

Limitations ..................................................................................................................................... 102 

Using IDEA Auto-SYNC ................................................................................................................... 104 

Starting IDEA Auto-SYNC ............................................................................................................... 106 

Recommended Calibration Images ........................................................................................... 106 

Creating CHP Files .......................................................................................................................... 108 

Location of CHP Files ..................................................................................................................... 108 

Windows 10 (64-bit) Installation ............................................................................................... 109 

Using Auto-SYNC Advanced Options ............................................................................................. 109 



 

TIMS MVP Setup and Configuration Guide               xxi 

Two Methods for Creating CHP File .......................................................................................... 112 

Automatic .................................................................................................................................. 112 

Interactive ................................................................................................................................. 112 

Next Step: Run Auto-SYNC for the Input Connection .................................................................... 112 

IDEA Auto-SYNC with RGB/VGA/DVI Analog Video ................................................................... 113 

Select the Connection Type ........................................................................................................... 113 

Video Input Selection ................................................................................................................ 113 

Auto-SYNC Wizard ......................................................................................................................... 117 

Running the Auto-SYNC Wizard (Analog) ...................................................................................... 119 

Auto-SYNC Wizard ......................................................................................................................... 121 

AccuStream Auto-SYNC Wizard Step 1: Adjust HTotal for Analog Connections ........................... 122 

Aspect Ratio (HTotal) Adjustment Example ...................................................................... 123 

AccuStream Auto-SYNC Wizard Step 2: Adjust Phase Delay for Analog Connections .................. 128 

Example ..................................................................................................................................... 129 

AccuStream Auto-SYNC Wizard Step 3: Adjust Left/Right Framing for Analog Connections........ 132 

Example .................................................................................................................................... 133 

AccuStream Auto-SYNC Wizard Step 4: Adjust Top/Bottom Framing for Analog Connections .... 139 

Examples ................................................................................................................................... 140 

AccuStream Auto-SYNC Wizard Step 5: Adjust Brightness and Contrast for Analog Connections 144 

Examples .............................................................................................................................. 145 

AccuStream Auto-SYNC Wizard Step 6: Adjust Miscellaneous Settings for Analog Connections . 153 

Example .................................................................................................................................... 154 

After the Auto-SYNC Wizard is Finished for Analog Connections ................................................. 156 

Auto-SYNC Video Setting Controls ................................................................................................ 157 

Viewing the Info Setting ............................................................................................................ 157 

Changing the Comments ........................................................................................................... 158 

Changing Connection Settings ................................................................................................... 159 

Changing the Miscellaneous Settings ........................................................................................ 160 

Changing Pixel Adjustments Settings ........................................................................................ 161 

Frame Tab .................................................................................................................................. 163 

Changing Frame Video Settings................................................................................................. 163 

Definitions ............................................................................................................................. 164 

Gain/Contrast Setting ................................................................................................................ 164 

Changing AccuStream RGB Settings .......................................................................................... 165 

Automatic White Balance ..................................................................................................... 165 

Adjust Combined RGB Settings ................................................................................................. 166 

Saving and Undoing Changes to your Video Settings .................................................................... 167 

Saving an Image ......................................................................................................................... 167 

Aspect Ratio Verification Function ................................................................................................ 167 

Aspect Ratio Menu Selections ................................................................................................... 167 

Procedure for Using the Aspect Ratio Function ........................................................................ 169 



 

xxii                                                                                                                      TIMS MVP Setup and Configuration Guide 

Procedure for Non-Calibrated Images ........................................................................................... 173 

Change the Circle Width or Color .................................................................................................. 174 

Shortcut Keys ................................................................................................................................. 175 

Using Auto-SYNC for Digital Input Connections ......................................................................... 177 

Select the Connection Type ........................................................................................................... 177 

Auto-SYNC for Digital Connections ................................................................................................ 181 

Auto-SYNC Wizard Step 1: Creating an Area Of Interest for Digital Connections ......................... 182 

Example ................................................................................................................................. 182 

AccuStream Auto-SYNC Wizard Step 2: Adjust AOI Top/Bottom Framing for Digital  
Connections ................................................................................................................................... 185 

Example ................................................................................................................................. 185 

AccuStream Auto-SYNC Wizard Step 3: Adjust Brightness and Contrast for Digital Connections 187 

Examples ............................................................................................................................... 188 

AccuStream Auto-SYNC Wizard Step 4: Adjust Miscellaneous Settings for Interlaced  
Digital Video .................................................................................................................................. 195 

Example ................................................................................................................................. 196 

After the Auto-SYNC Wizard is Finished ........................................................................................ 198 

Viewing the Info Setting ............................................................................................................ 199 

Changing the Comments ........................................................................................................... 200 

Changing Connection Settings ................................................................................................... 201 

Connection Settings .............................................................................................................. 202 

Changing the Miscellaneous Settings ........................................................................................ 202 

Auto-SYNC Video Settings Tabs ................................................................................................. 203 

Changing Pixel Adjustments Settings .................................................................................... 203 

Changing Frame Video Settings ............................................................................................ 204 

Changing Gain/Contrast Setting ........................................................................................... 205 

AccuStream RGB Gain/Offset Settings .................................................................................. 206 

Adjust Combined RGB Settings ............................................................................................. 206 

Saving and Undoing Changes to your Video Settings ............................................................... 207 

Saving an Image ......................................................................................................................... 207 

Using Auto-SYNC for SDTV Connections........................................................................................ 208 

Select the Connection Type ....................................................................................................... 208 

Phase Determination ................................................................................................................. 212 

Running the Auto-SYNC Wizard ..................................................................................................... 213 

AccuStream Auto-SYNC Wizard Step 1: Adjust HTotal for SDTV Connections .............................. 215 

Adjusting Htotal for SDTV using the DVI Adapters .................................................................... 215 

Aspect Ratio (HTotal) Adjustment Example .................................................................. 217 

AccuStream Auto-SYNC Wizard Step 2: Adjust Left/Right Framing for SDTV Connections .......... 221 

Example ................................................................................................................................. 222 

AccuStream Auto-SYNC Wizard Step 3: Adjust Top/Bottom Framing for SDTV Connections....... 228 

Examples ............................................................................................................................... 229 



 

TIMS MVP Setup and Configuration Guide               xxiii 

AccuStream Auto-SYNC Wizard Step 4: Adjust Brightness and Contrast for SDTV Connections .. 233 

Examples ................................................................................................................................... 234 

AccuStream Auto-SYNC Wizard Step 5 for SDTV Connections ...................................................... 242 

AccuStream Auto-SYNC Wizard Step 6: Adjust Miscellaneous Settings for SDTV Connections .... 243 

Example ................................................................................................................................. 245 

After the Auto-SYNC Wizard is Finished ........................................................................................ 247 

Viewing the Info Setting ................................................................................................................ 248 

Changing the Comments ............................................................................................................... 249 

Changing Connection Settings ....................................................................................................... 250 

Changing the SDTV Format ............................................................................................................ 251 

Changing the SDTV Miscellaneous Settings .................................................................................. 252 

Changing SDTV Settings ................................................................................................................. 253 

Changing Pixel Adjustments Settings ............................................................................................ 254 

Changing Frame Video Settings ..................................................................................................... 255 

Saving and Undoing Changes to your Video Settings .................................................................... 256 

Saving an Image ............................................................................................................................. 256 

TIMS MVP System Maintenance ............................................................................................... 257 

Scope ............................................................................................................................................. 257 

Notes ............................................................................................................................................. 257 

About the TIMS Review Software ............................................................................................. 257 

Maintenance Requirements .......................................................................................................... 258 

What You Need ......................................................................................................................... 258 

Time Required ........................................................................................................................... 258 

Maintenance Frequency............................................................................................................ 258 

Why Study Storage Maintenance is Required ............................................................................... 258 

Recommendation ...................................................................................................................... 258 

How Delete Studies in TIMS MVP ............................................................................................. 258 

Optimize (Defragment) the Hard Drive ......................................................................................... 261 

Verify Disk Space ........................................................................................................................... 263 

Run a Check Disk on the Hard Drive .............................................................................................. 264 

Verify TIMS MVP Disk Study Space Limit ....................................................................................... 267 

Clean TIMS Computer Air Grills ..................................................................................................... 268 

Revision History ............................................................................................................................. 269 

TIMS MVP / Review Maintenance Checklist Log ........................................................................... 270 

Appendix A: Hazardous Substance Statement ........................................................................... 271 

Appendix B: Modalities Without an Auxiliary Video Output ...................................................... 272 

Using a Video Splitter .................................................................................................................... 272 

Index ....................................................................................................................................... 273 



Table of Contents  

xxiv                                                                                                                  TIMS MVP Setup and Configuration Guide

  

Glossary of Acronyms 

AE 

Application Entity (Identifies nodes) 

BNC 

Bayonet Nut Connector 

CHP 

Common Hardware Profile file (CHP file extension) 

DICOM 

Digital Imaging and Communications in Medicine 

DVI 

Digital Video Interface 

IP 

Internet Protocol 

MVP 

Medical Video Platform 

PACS 

Picture Archiving and Communications System 

QR 

Query/Retrieve 

SCP 

Service Class Provider 

SCU 

Service Class User 

SOP 

Service Object Pair 

USB 

Universal Serial Bus



                      Get Connected  

TIMS MVP Setup and Configuration Guide           1                                                                                                                         

  

Get Connected 
Connecting your TIMS Medical Video Platform (MVP) System comprises the following steps, 

reviewed in this chapter: 

▪ Conduct a Site Survey 

▪ Set Region AC Voltage Setting 

▪ Make Standard PC Connections 

▪ Make Modality Connections 

▪ Connect Trigger (optional) 

▪ Configure Network 

After you connect your system, additional software configuration steps are required before the 

system is ready to use: 

▪ Configure Security (optional)   Go to Page 87 

▪ Configure Channels and DICOM Class Lists Go to Page 27 

▪ Configure Modality Worklist   See Operator’s Guide 

▪ Configure DICOM Send    See Operator’s Guide 

Site Survey 

Before you set up the hardware connections or software configuration for your TIMS MVP 

system, you should perform a site survey to establish general requirements. 

• Determine requirements and location of TIMS units, including proximity to power and 

network adapters. 

• Determine the type, number, and location of video imaging devices you will connect to 

the TIMS MVP system. 

• Determine if distances to video sources will exceed 6 meters, in which case. It may 

require a video amplifier. 

• Determine network settings (domain or workgroup, dynamic or static IP address, and so 

on). 
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Typical TIMS MVP System Installation 

These are the necessary preparation and installation steps you need to take for a typical TIMS 

MVP installation. You may have a configuration that requires additional steps not listed here. 

Here is a checklist with all recommended steps. 

TIMS MVP System Checklist 

(site option) means you site may not have or require the step listed. 


TIMS MVP System serial number: _____________________________                                                       

TIMS MVP System Rev:          _____________________________ 

 Unpack TIMS MVP System from its shipping boxes. 

 
Determine the mounting location – usually in a control room. 

• Requires three AC outlets (TIMS MVP System, LCD & Isolator-

Splitter) 

• Requires network connection 

• Modality video & Trigger 

 
Install the TIMS MVP System. 

• Connect LCD, Keyboard, Mouse, network, audio cables 

• Set the TIMS MVP System Windows system name 

• Set TIMS MVP System IP Address/Subnet/Gateway 

• Set verify region and time settings. 

• Calibrate touchscreen. (site option) 

• Install anti-virus software (site option) 

 
Make the TIMS MVP System connections. 

• Connect TIMS MVP System to the network. 

• Connect Isolator video and trigger to TIMS MVP System. 

• Connect Modality video and trigger to Isolator. 

• Connect room monitor to the Isolator. 

 
Install and configure microphone/speakers. (site option) 

• Omni or wireless microphone. 

• Configure microphone and speaker levels in Windows. 

 
TIMS MVP System Auto-SYNC to image. 

• Adjust image aspect ratio and quality. 

• Adjust framing. 

• Adjust black/color level and gain. (site specific) 
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TIMS MVP System Checklist 

(site option) means you site may not have or require the step listed. 


Configure TIMS MVP System with TIMS MVP software. 

• Set Worklist server AE title, IP address and port number. 

• Configure TIMS MVP Send/PACS 

• Configure a Worklist server. 

 
Create a TIMS MVP channel. 

• Set CHP. 

• Set trigger mode. 

• Set monochrome or color. 

• Set compression mode. 

• Save channel. 


Test configuration. 

• Create a test study. 

• Query site Worklist for patient information. 

• Capture images using the trigger. 

• Send images to PACS.  

• Review images on PACS. Make adjustments, if needed. 

• Delete test studies. 

• Verify touchscreen calibration. (site option) 

• Verify image and Auto-SYNC adjustments. 


Install and configure TIMS Review workstations. (site option) 

• Review studies or images on TIMS Review workstation 


Save and backup TIMS MVP configuration. 

• Email system configuration zip file to support@tims.com. 
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Typical System Unit 

Note: The appearance of your system, its backplane ports, and supplied connection hardware 

may differ, in some respects, from what is shown and described here. 

Front View (Front Panel) 

 

Front Panel 

 

 Standby Switch 

 
HDD Activity – Hard Drive Activity light. 

 
System Power – Indicates when power is ON. 

 
USB (2) 

 
Not Used. 

Front Panel 

1 

     
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Rear View (Backplane) 

 

Connecting your TIMS MVP System comprises standard PC connections (including network 

connections) and Modality (imaging device) connections.  

Indicate PC Connections 

Your TIMS MVP System is equipped with a full range of standard PC connection options and 

peripherals. The items included with TIMS MVP: 

• External Medical Grade Power Supply — US, Europe, or the UK (as supplied)  

IMPORTANT: Make sure the external power coupler is not difficult to disconnect from a power 

outlet. This includes ensuring it is not blocked or in an area where it would be very difficult to 

access and/or remove quickly. 

• Keyboard 

• Mouse 

• DVI-D Cable 

• BNC Barrel Connectors, Qty 6 

• S-Video Cable 

• Network cable, Cat6  

• BNC Video Cable, Qty 2 

• BNC Trigger Adapter 

• Mono BNC to DVI Video Adapter 

  

Modality Connection 

PC Connections Power Supply Audio Connections 
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Power Supply Connection 

 USB 3.0 (2) 

Typically used for higher speed DVD drives, 
keyboard and mouse 

 

 
DisplayPort (2) 

Used to connect a video source to a display 
device such as a computer monitor 

The DP on the right side is the primary DP 
connection 

 

 
Network (2) 

LAN 2 is normally not used – available for 
accessory devices 

 

 
USB (2) 

Typically used for keyboard and mouse 

 

 
Line Out – Stereo 
Microphone Input 

 

 

6 

  

 

  
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Power Supply Connection 

 

 

 External Power 
Supply 

 

IMPORTANT: 
Make sure you 
feel the cable 
“click” into the 
power connection 
to ensure it is a 
secure 

connection. 

 

 

Low voltage sealed connection 

 

Modality Connections 

Your TIMS MVP System is equipped with one high-performance video capture board. It is: 

AccuStream HD+ 

For Standard and High Resolution RGB  

For Standard and High-Resolution Monochrome 

For NTSC / PAL - S-Video and Composite (requires an S-video to  

Composite adapter) 

To Make Modality Connections 

To make modality connections, you must: 

1. Determine the type of video source you are connecting to. 

2. Determine the type of supplied connector to use.  

  

 

Make sure you 

feel the power 

cable “click” 

into the power 

connection. 
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Use the following table for guidance. 

Non-NTSC/PAL 

Video Source Connector 

RGB 

3 Wire 

4 Wire 

5 Wire 

or  

 

Monochrome 

Sync 

Composite 

Horizontal 

Vertical 

 
DVI to 5-BNC Cable 030093, 
Male or  

 

 

 

 

 

DVI to BNC adapter, 030175  

DVI to 5-BNC Cable 030093, 
Male 
 

NTSC/PAL 

S-Video S-Video Cable, Standard 4-Pin 
DIN, Male, 030102   

Composite Color Video S-Video to BNC adapter, 
030193 
S-Video to RCA, 030194 
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AccuStream Express HD+ 

Trigger Adapter 

– Male Phone to 

Female BNC    

      

 Y/C IN – S-video to S-

video cable or for 

composite color an S-

video to composite color 

adaptor (optional) 

      

    

DVI-I IN – DVI to 

BNC Cable or DVI to 
BNC Adaptor 

          

 HDMI IN - DVI-D to 

HDMI cable (optional) 

or HDMI to HDMI cable 

(optional) 
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 Trigger Adaptor Male Phono Adaptor (P/N: 030123) 

 

 
DVI-In – RGB or 
Monochrome 

DVI-D to VGA cable (optional) 

or 

DVI to BNC Cable (P/N: 030193) 

or  

DVI to BNC Adaptor (P/N: 030175) 

 

 
HDMI In – NTSC or PAL DVI-D to HDMI cable (optional)  

or  

HDMI to HDMI cable (optional) 

 
Y/C In – NTSC or PAL S-video to S-video cable (P/N: 030102) 

or 

for composite color: an S-video to composite 
color adaptor (optional) 

 

 

Optional composite video 
cable 

BNC to S-video adaptor (P/N: 030193) 
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Connecting Your Video Source to AccuStream HD+ 

DVI-IN Video Sources 

A DVI to BNC cable is supplied for imaging devices: 

For RGB Connections 

DVI to 5-BNC Cable (P/N: 030193), Male 

Connection Steps: 

Using the color-coded BNC wires as your guide: 

1. Connect DVI to TIMS . 

2. Make the Red, Green, and Blue connections to device. 

3. Make the Sync connection to device: 

• If Composite Sync, use Gray for Comp/H-Sync  

• If Horizontal Sync, use Gray for H-Sync 

• If Vertical Sync, use Black for V-Sync 

 

For Monochrome Connections 

DVI to 5-BNC Cable (P/N: 030193), Male 

Connection Steps: 

Using the color-coded BNC wires as your guide: 

1. Connect DVI to TIMS . 

2. Make the Green to Monochrome video connection. 

3. Make the Sync connection: 

• If Composite Sync, use Gray for Comp/H-Sync  

• If Horizontal Sync, use Gray for H-Sync 

• If Vertical Sync, use Black for V-Sync 
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For Monochrome Connections only 

DVI to BNC Adaptor (P/N: 030175) 

Connection Steps: 

Using the DVI to BNC Adaptor: 

1. Connect DVI end of the adaptor to TIMS . 

2. Connect the BNC end of the adaptor to a BNC cable. 

For DVI Connections 

DVI-Digital to DVI-Digital, P/N: 030096 

Connection Steps: 

1. Connect DVI male to TIMS . 

2. Make the DVI connection to the video source. 

Optional Trigger 

Connect to TIMS and to the trigger device. 

Note: A trigger is a foot pedal or pushbutton device for 

starting and stopping video capture. 

S-Video (Y/C) Color Video Sources or Composite Color Video 

S-Video cables are supplied for NTSC/PAL imaging devices: 

 

For S-Video (Y/C) Connections 

BNC Cable, Standard 4-Pin DIN, Male 

BNC Cable, Standard 4-Pin DIN, Male to Composite Color Adaptor 

Connection Steps: 

1. Connect to TIMS . 

2. Connect the S-video to Composite Color Video adaptor (P/N: 030193) 
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Optional Trigger 

Connect to TIMS  and to the trigger device. 

Note: A trigger is a foot pedal or pushbutton device for 

starting and stopping video capture. 

 

HDMI Video Sources 

HDMI Cables are optional for NTSC/PAL imaging devices: 

For HDMI Connections 

HDMI to DVI-D Cable (P/N: 030191) 

HDMI to HDMI Cable (P/N: 030190) 

Connection Steps: 

1. Connect to TIMS . 

2. Make DVD-I or HDMI Connection to device. 

Optional Trigger 

Connect to TIMS  and to the trigger device. 

Note: A trigger is a foot pedal or pushbutton device for 

starting and stopping video capture. 

Triggers 

For a trigger to use with the TIMS MVP system, contact the modality manufacturer or service 

provider. Also, you can use the TIMS relay trigger as an option. For the relay trigger, contact 

TIMS at: 

Phone:  (001) 978-458-4624 ext. 204 

Email: support@tims.com 

  

 

 

file:///C:/Users/Jack/AppData/Local/Temp/support@tims.com
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FI Video Splitter Isolator 

 

 

Single Channel Medical Video Splitter/Isolator P/N 012009-100 

 

The video signal provides a second video source to a TIMS unit. This video source is for 

monochrome connections only. The video splitter isolator would be placed between the 

modality and the video monitor. 

 

 

 

 

Video IN Video OUT 

Trigger IN TIMS connection Trigger OUT 
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Network Setup 

Your TIMS MVP System requires standard network configuration. 

Consult your network administrator to determine the following: 

• Whether the system is to be part of a domain or a workgroup. 

• Whether the system is to have a dynamic or static IP address. 

Set Computer Name, Domain/Workgroup 

To set computer name, domain/workgroup: 

1. Open Start menu > Control Panel > System > Advanced System Settings > Computer 

Name tab. 

2. To join a domain, use the Network Identification Wizard (click Network ID).  
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If Static IP Address Is Required 

If a static IP address is required: 

1. Right-click on the Windows Start icon and select Network Connections.  

 

2. For your network connection, click the Connections type Ethernet. 

 

  



                      Get Connected  

TIMS MVP Setup and Configuration Guide           17                                                                                                                         

  

3. Click the Properties button to access the Ethernet Properties. 

 

 

4. Select Internet Protocol Version 4 (TCP/IPv4) from the connection list. 
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5. Click the Properties button. Select Use the following IP address. Enter the required IP 

and DNS information. 

 

6. Click OK. 

Verifying Audio 

Note:      It is recommended that you verify audio settings before installing TIMS MVP software. 

In order to use the synchronized audio capture feature on the TIMS MVP System, you should 

verify the audio settings on your TIMS MVP system to ensure that your recording and playback 

will work properly with TIMS MVP. 

To verify your TIMS MVP system audio settings for microphones and speakers: 

1. Open Start menu > Control Panel and select Sound. 
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When the Sound Properties dialog appears, click on the Recording tab. It is 

recommended that you keep the selected Default devices as your selection for Sound 

playback and recording. 

 
 

2. To verify that a microphone is selected as the recording device, make sure there is a 

green check on the microphone icon. If it is not, then select the microphone and click 

the Set Default button. 

3. Click OK. 

4. After you verify the microphone, right-click the sound icon  in the lower right-hand 

corner of the Windows toolbar. 

5. Click Open Volume mixer and the Volume Mixer dialog appears. 

First verify that the 

microphone is the 

chosen sound 

recording device. 
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6. Verify that all of the Volume Control selections are not set to Mute. If the volume is set 

to mute, the volume icon has a stop icon over it. Click on the icon to unmute.  

 

7. After you verify the sound playback, click the X to close the Volume Mixer dialog. 

  



                      Get Connected  

TIMS MVP Setup and Configuration Guide           21                                                                                                                         

  

Verify the Speaker Setup 

1. Open Start menu > Control Panel and select Sound. 

2. When the Sound Properties dialog appears, click on the Playback tab. 

3. Under Playback, click Configure. 

4. Verify the speaker setup.  

▪ If the setup is correct, click Cancel to exit the Speaker Setup wizard and 

then click OK.  

▪ If the setup is incorrect, change the selections, click Finish and then click 

OK to exit the properties dialog. 

Test Your Microphone and Speakers for Use with TIMS MVP 

To test your microphone and speakers for use with TIMS MVP: 

1. Open Start menu > Control Panel and select Sound. 

2. When the Sound Properties dialog appears, click on the Recording tab. 

 

 

 

 

  

If the microphone 

selection is 

incorrect, click the 

selection. 
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3. Click Configure to test the microphone connected to your TIMS MVP system. Click Set 

up microphone from the configuration settings. 
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4. When the Microphone Setup Wizard starts, select the type of microphone you are using 

and click Next. 

 

 

 

5. When the Set up your microphone dialog appears, follow the instructions to prepare to 

speak into the microphone.  
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6. Test the microphone by speaking the phrase shown in the dialog.  

• If the meter is moving, then the microphone is working properly, click Next. 

• If the meter is not moving, click Cancel and go to the verification procedure on page 

18. 

 

 

7. Click Finish and the click the X to close the configuration menu. 

 

 

Make sure the 

meter is moving 

when you speak if 

you need to redo 

the verification 

procedure. 
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8. Select the Playback tab on the Control Panel Sound dialog. Click on the Playback 

speakers you are using and then click Configure. 

 

 

9. Choose your playback configuration. In this example, the speakers are used for 

playback. Click Test to test the sound for the playback device. Click Next. 
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10. Click Next when the Select Full Range Speakers dialog appears and then click Finish. 

 

 

11. Click OK to close the Sound dialog.   
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Getting Started 

Configuring Channels 

The chapter discusses configurable settings and features of the TIMS MVP software for image 

acquisition and medical video system settings: 

• Selecting Image Acquisition Settings  

• Selecting DICOM Class Settings 

• Selecting Medical Video System File Compression Settings 

Configuring Channels means you can set all the properties that determine image acquisition and 

medical video system data fields. You do this in the TIMS MVP Channel Configuration window.  

A channel comprises of image acquisition properties for a medical modality and the data 

acquisition properties that define the associated DICOM class. 

Configuring Channel Settings 

From the TIMS MVP Channel Editor, you can add, delete, edit or duplicate a channel. 

To access the Channel Editor page: 

1. Click the Help menu and select Configuration. 
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2. From the TIMS MVP Config page, click the Channels tab. 

 

 
 

Result: The Channel Editor opens. 

Add a New Channel 

1. Click  to add a channel. 
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2. Complete the fields in the Channel Editor using the table on the next page. 

 

 
 

When a trigger is detected the following options appear at the bottom of the Channel 

Editor. 
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Option Description 

Name Provide a name which helps you identify how the channel is used. 
For example, type the name Heart. 

DICOM Class From the drop-down menu, select the modality type.  Scroll through 
the list to find the correct modality.  
 
For example, for the heart, select PT-Positron Emission Tomography 
Image Storage. 
 

 

Modality 
Override 
(Optional) 

From the drop-down menu, select the shortened modality identifier 
name. Scroll through the list to find the correct modality. 
 
For example, you might want to use PT rather than PT-Positron 
Emission Tomography Image Storage.  
 

 

Video Source Select the video source from the drop-down menu. Select the 
connection on the AccuStream board that is being used for the 
channel. 
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Option Description 

Frame Rate The playback speed is determined by the default animation speed of 
30 frames per second or another value that you can set from the 
drop-down menu. 
 
It recommended you keep the default of 30, unless you need the 
lower animation speed. 

 

Rate type Two options for choosing a frame rate type: 

• Best Frame Rate – This will use the actual frame rate as close as 
possible to the rate chosen in the Frame Rate field. 

• Fixed Frame Rate – This will always give you the frame rate 
specified in the Frame Rate field. 

Capture Type Select the capture type you will use with the modality. It is either a 
JPEG (JPG) image or an MP4 video. 

Video 
Monochrome 
or RGB 

Click the video type that you will capture. It is either Monochrome 
(Black/White) or RGB color (Red, Green, Blue) 

Quality This option sets the compression for video. The Quality default is 
90% for the best video size and quality. If you need to change this 
option, use the slider to select the compression percentage you 
want. 

Custom CHP 
File 

If you want to use a custom Common Hardware Profile, use the 
drop-down menu to make your selection. 

• None – The default selection – no custom CHP file chosen. 

• Import Format… - To import a CHP file, select this option and the 
Import CHP File dialog appears. Browse for the file and select it, 
click the Import button. 

• Reveal formats folder… - To import a CHP file from a TIMS MVP 
folder, select this option and the TIMS MVP folder opens. Select 
the CHP file and double-click the file to select. 
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Option Description 

Audio Source Use the drop-down menu to select the TIMS MVP audio sources 
available on your TIMS computer. All available audio sources appear 
in green. 

If the audio source is connected to the TIMS, the selection will 
indicate the connection type (such as USB) or the location of the 
connection on the TIMS unit. 

The selections also include TTS (Text to Speech) audio. 

 

Mono or 
Stereo 

Select the audio type you are using with TIMS – Mono or Stereo. 

Sample Rate Select an audio sample rate from the drop-down menu. Sample 
Rate defines the number of samples per second taken from a 
continuous audio signal. 

 

Bits Per 
Sample 

Select the bits per sample from the drop-down menu. The Bits Per 
Sample indicates the sample size for the audio file in bits per 
sample. 

Snapshot 
Type 

Select the image Snapshot Type from the drop-down menu. The 
default selection is a JPEG (JPG) file. 

Image 
Monochrome 
or RGB 

Click the image type that you will capture. It is either Monochrome 
(Black/White) or RGB color (Red, Green, Blue) 
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Option Description 

Quality This option sets the compression for image. The Quality default is 
90% for the best image size and quality. If you need to change this 
option, use the slider to select the compression percentage you 
want. 

Trigger 
Source 

Use the drop-down menu to select the Trigger Source available on 
your TIMS computer.  

 

Trigger 
Action 

Select how you want to use the trigger for capturing video and 
images. There five options:  
 

 

• None – Trigger is attached to the TIMS unit but is not going to be 
used 

• Toggle Record – Use the foot pedal to start and stop recording 
multiple times for a video so you can capture specific intervals  

• Record – Use the trigger to start recording and stop recording a 
video. 

• Record For – Use to set it to a certain duration for the capture 
length. Use Record Length (ms) to change the duration. 
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Option Description 

Trigger 
Activation 

This allows streaming capture of video to be started and stopped 

each time the pedal is depressed. Choose the selection that fits the 

pulse from the trigger when it is depressed. 

• While Low 

If the foot pedal creates a LOW going pulse, and stream capture 

is desired only while the pedal is depressed, use this option. 

• While High 

If the foot pedal creates a HIGH going pulse, and stream capture 

is desired only while the pedal is depressed, use this option. 

Retrigger 
Delay (μs) 

Enter the milliseconds that must elapse before another trigger event 

is recognized. 

Record Delay 
(frames) 

Enter the number of frames that must elapse before another trigger 

event is recognized. 

 

3. Click OK to add the channel. 

Result: The channel is added to the list of channels. 

 

 

Delete a Channel 

You delete a channel from the TIMS MVP Config Channel tab. 
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1. Select the channel you want to delete from the menu. 

 

2. Click the Delete icon (minus sign) below the list of channels to delete the selected 

channel. 

3. Click OK to confirm you want to permanently delete the channel when you receive the 

prompt. 

 

Result: The channel is removed from the list of channels. 

Edit a Channel 

You edit a channel from the TIMS MVP Config Channel tab. 

1. Select the channel you want to edit from the channels menu. 

 

2. Click the Edit  icon. The Channel Editor page opens. 



Getting Started  

36                                                                                                                  TIMS MVP Setup and Configuration Guide  

3. Make any required edits and click OK when done. 

Note: Go to step 2 in Configuring Channel Settings on page 27. 

Duplicate a Channel to Create a New Channel 

You duplicate a channel from the TIMS MVP Config Channel tab. 

1. Select the channel you want to duplicate from the list of channels. 
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2. Click the Duplicate  icon. The Channel Editor page opens.  

 

 

3. Enter a new unique name in the Name field at the top of the page. 

4. Make any required edits needed for the new channel. 

Note: Go to step 2 in Configuring Channel Settings on page 27. 

5. Click OK when done. The new channel appears in the Channels list. 

Rename a Channel 

You rename a channel from the TIMS MVP Config Channel tab. 
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1. Select the channel for which you want to make a name change from the channels list. 

 

2. Click the Edit  icon. The Channel Editor page opens. 

3. In the Name field, type in a new name for the channel and click OK when done. 

The channel appears in the channels list with the new name. 

DICOM Class Customization 

This configuration option lets you can edit an existing DICOM class or add a new DICOM class for 

your channel options. This option is accessed through the configuration General tab. 

To add a new or edit a DICOM class customization: 

1. Go to Help and select Configuration. 

• Log in to Configuration with your Admin password. 

2. Select the General tab and click the DICOM Classes button. 
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3. Result: The DICOM Class Customization dialog opens: 

 

4. Click the down arrow to open the drop-down menu. 

 

NOTE: To add a New Customization, select a DICOM class from below the New  

Customization menu item. To Edit Customization, select a DICOM class from below the 

Edit Customization menu item. 
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5. Select the DICOM Class from the drop-down menu. The following dialog appears: 

 

 

6. Enter any tag you want to add or you want to filter out for the DICOM Class. Press Enter. 

• Tags: Type in the first few letters or numbers of a tag you want to include for 

the DICOM Class. Select the tag from the drop-down menu, as shown below: 
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• Filters: Type in the letters or numbers of a tag you want to filter out for the 

DICOM Class. Select the tag from the drop-down menu as shown below: 

 

 

7. Click OK. The new or edited DICOM class is saved. 
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Configure the TIMS MVP Worklist 

The Worklist is configured on the TIMS MVP Configuration page. This page allows you to: 

• Add a worklist to the TIMS MVP system 

• Open the Worklist by default when you open TIMS MVP 

• Override the Worklist Application Entity (AE) title 

• Add local settings for the worklist 

• Test the Worklist settings 

To access the Worklist configuration page: 

1. Click the Help menu and select Configuration. 

 

2. From the TIMS MVP Config page, click the Worklist tab. 

 
 

Result: The Worklist page opens. 

 

 

 



Getting Started 

TIMS MVP Setup and Configuration Guide                                                                                               43  

 

 

Configuring Worklist Settings 

There are four options you configure on the Worklist home page: 

• Auto-hide Protected Health Information (PHI) from the worklists. 

• Set the default when you open TIMS MVP to display the worklists 

• Override the Application Entity (AE) title 

• Configure the Worklist local settings 

Auto-hide PHI 

To automatically set up TIMS MVP to auto-hide PHI from a worklist, click the checkmark for the 

Auto-hide PHI option as shown below: 

 

Open to Worklist 

You can set up your TIMS MVP to automatically open the worklist when you first open the TIMS 

MVP application. To do this: 
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• Click the Open to Worklist checkbox on the Worklist page. If you decide you no longer 

want to open the Worklist when you start TIMS MVP, simply click to uncheck the 

checkbox. 

 

 

Override the Application Entity Title 

IMPORTANT: This will override the system wide Application Entry (AE) Title used in all DICOM 

services. 

To override the AE Title: 

1. Go to the Worklist tab on the TIMS MVP Config page. 

 

2. Click the AE Title Override checkbox to enable the override.  

 

Result: A message appears warning you about the change. 

 



Getting Started 

TIMS MVP Setup and Configuration Guide                                                                                               45  

3. Click OK and the AE Title Override is selected and a Local AE Title name field opens 

where you can type in the name change. 

 

4. Type in a new name below the AE Title Override checkbox. 

 

5. Click Apply. You have saved your changes and you need to restart the effected DICOM 

services. 

 

6. Click OK. 

Remove the AE Title Override 

To remove the AE Title Override, click to uncheck the checkbox. The override AE Title is deleted. 

The name is removed from the DICOM Servers page. You need to restart the effected DICOM 

services. 
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Add Worklist Local Settings 

To add the worklist local settings: 

1. Click the Local Settings button. 

 
 

Result: The Local Settings page displays. 

2. Complete the fields in the Local Settings page using the table below. 

 
 

Use the table to enter the local settings. 

Option Description 

Local 

Local AE Title Provide a local Application Entity (AE) title. The default 
is TIMS_MVP. 

Receive Port Type in the port number for Service Class Provider of 
the remote system. The default port is 104. 

Storage Commit 

Listener AE 
Title 

Type in the listener Application Entity (AE) title for the 
PACS.  

Port Number Type in the port number for the PACS. 



Getting Started 

TIMS MVP Setup and Configuration Guide                                                                                               47  

Option Description 

IP Address Filtering 

IP Address 
Filtering (4) 

Enter any additional IP addresses or host names that 
DICOM Receive will respond to. This is helpful when 
you move a TIMS MVP system from one room to 
another which is connected to a different network 
segment. 

DICOM Logging Select the logging type you would like to view by 
clicking the down arrow to display the drop-down 
menu: 
 

 

 

Errors and warnings only is the default selection. 

 

3. Click OK to save the local settings. 

  



                      Getting Started  

48                                                                                                      TIMS MVP Setup and Configuration Guide 

Add a Worklist 

To add a worklist to the TIMS MVP system: 

1. Click  to add a Worklist. 

 

2. Complete the fields in the DICOM Worklist page using the table below. 

 
 

Option Description 

Name Provide a name which helps you identify the worklist. 
For example, type the name Cardiology. 

SCP AE Title Type in a name for the Service Class Provider (SCP) 
Application Entity (AE) Title of the receiving system.  

SCP Port Type in the port number for Service Class Provider of 
the remote system. The default port is 104. 

SCP IP Address Type in the Service Class Provider IP address. 

Modalities Type in the name of the modality that this worklist will 
use. 

Use Worklist 
UIDs 

Click to select if the Worklist uses Unique Identifiers 
(UIDs), 
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Option Description 

Allow Manual 
Reload 

Let you enter a filter and then click the Reload button. 
This is necessary when the modality worklist is not 
updating immediately. 

Ignore Study 
Dates 

When selected, allows you to view everything on a 
modality worklist regardless of the date. 

Filter File The filter file lets you add tags for information you want 
to filter out from worklists. You can edit or add new 
filter files. 

1. Click the text box below this Filters heading and 
start typing a filter you want to add. You are 
presented with a list of filter options. For example, 
if you typed the word thickness, you are presented 
with a variety of options that contain that word: 

 

2. Select the description you want to use as a filter. 

• You can add as many filters as required. 

3. Click OK when done. File filters out the specified 
information on a worklist related to the selected 
tag(s). 

Remove Filters: Click the circle  icon to the left of 
the filter to delete it. 

Edit Filters: Click the pencil  icon next to the filter 
name and then click the icon again to edit. Make your 
changes and click OK when done. 

Delete Filters: Click the trash can  icon and then click 
it again to delete a filter from the worklist. 

 

3. Before you can click OK to save the new worklist, you must click the Test button. 

4. If the test is successful, click OK. If the test was unsuccessful, edit your worklist options 

and click Test again. 

5. Click OK to save the Worklist.  
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Delete a Worklist 

To delete a worklist: 

1. Select the Worklist you want to remove. 

 

 

2. Click the minus sign below the list of Worklists. A confirmation asks if you want to 

permanently delete the selected worklist. Click OK. 

 

Result: The worklist is removed from the list. 
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Edit a Worklist 

To edit an existing worklist: 

1. Select the Worklist you want to edit. In this example, Urgent Care Westview is selected. 

 

2. Click the Edit  button and the Worklist configuration pages displays. 

 

3. Make the edits you require on the Worklist configuration page. 

For details on each field, go to step 2 in Add a Worklist. 

 

IMPORTANT: If you make changes to the Remote AE Title, Remote IP or Remote Port 

fields, you must test the worklist before you can click OK to save. 
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4. Clock OK to save.  

• If you are required to test your changes, click TEST SEND button and the click 

OK. 

• If the test fails, make changes to your entries and click the TEST SEND button 

again. 

 

Duplicate a Worklist 

To duplicate a worklist: 

1. Select the Worklist. 
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2. Click the Duplicate  icon. The Worklist configuration page appears. The Name field 

will be blank. 

 

3. Type a new unique name in the Name field. 
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4. Click OK and the new Worklist displays. 

 

Configuring DICOM Destinations 

The DICOM Server is configured on the TIMS MVP Configuration page. This page allows you to: 

• Add a DICOM server to the TIMS MVP system 

• Edit a DICOM server 

• Delete a DICOM server 

• Duplicate the configuration from an existing DICOM server 

• Override the Worklist Application Entity (AE) title 

• Add local settings for the worklist 

Configuring DICOM Server Settings 

There are two options you configure on the DICOM Servers home page: 

• Override the Application Entity (AE) title 

• Configure the Worklist local settings 

To configure the DICOM Server settings: 

1. Click the Help menu and select Configuration. 
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2. From the TIMS MVP Config page, click the DICOM SERVERS tab. 

 
 

Result: The DICOM Servers page opens. 

 

Override the Application Entity Title 

IMPORTANT: This will override the system wide AE Title used in all DICOM services. 

To override the AE Title: 

1. Go to the DICOM Servers tab on the TIMS MVP Config page. 
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2. Click the AE Title Override checkbox to enable the override.  

 

Result: A message appears warning you about the change. 

 

3. Click OK and the AE Title Override is selected and a Local AE Title name field opens 

where you can type in the name change. 

 

4. Type in a new name below the AE Title Override checkbox. 
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5. Click Apply. You saved your changes and you need to restart the effected DICOM 

services.  

 

6. Click OK. 

Remove the AE Title Override 

To remove the AE Title Override, click to uncheck the checkbox. The override AE Title is deleted. 

The name is removed from the Worklist page. You need to restart the affected DICOM services. 

Add DICOM Server Local Settings 

To add the DICOM Server local settings: 

1. Click the Local Settings button. 

 
 

Result: The Local Settings page displays. 

2. Complete the fields in the Local Settings page using the table below. 
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Option Description 

Local 

Name Provide a local Application Entity (AE) title. The default 
is TIMS_MVP. 

Receive Port Type in the port number for Service Class Provider of 
the remote system. The default port is 104. 

Storage Commit 

Listener AE 
Title 

Type in the listener Application Entity (AE) title for the 
PACS.  

Port Number Type in the port number for the PACS. 

IP Address Filtering 

IP Address 
Filtering (4) 

Enter additional IP addresses or host names that 
DICOM Receive will respond to. This is helpful when 
you move a TIMS MVP system from one room to 
another which is connected to a different network 
segment. 

 

3. Click OK to save the local settings. 

Add a DICOM Send Server 

To add a DICOM Send Server to TIMS MVP: 

1. Click  to add a DICOM server. 
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2. Complete the fields in the DICOM Send page using the table below. 

 

 
 

Option Description 

Name Type in the name of the Service Class Provider (SCP).  

Remote AE 
Title 

Type in a name for the remote Application Entity (AE) 
Title of the DICOM send system.  

Remote 
IP/Name 

Enter the remote IP address or name for the DICOM 
send system. 



                      Getting Started  

60                                                                                                      TIMS MVP Setup and Configuration Guide 

Option Description 

Image Format 
Conversion 

From the drop-down menu, select the image 
compressions type you are using. 

• Native – Uses the current format of the image file. 

• Uncompressed Explicit – Means the DICOM transfer 

syntax is Explicit VR, Little Endian. The images are 

converted to uncompressed if this is not the native 

capture format. 

• Lossy - Uses some reduction in image quality. 

• Lossless - Uses no reduction in image quality.  

• Uncompressed Implicit – means the DICOM transfer 

syntax is Implicit VR, Little Endian. The images are 

converted to uncompressed if this is not the native 

capture format.  

 

MP4 Transfer 
Syntax 

From the drop-down menu, select the MP$ transfer 
syntax: 

• Not Supported (default) 

• High profile level 4.1 

• Blu-ray, high profile level 4.1 

• High profile level 4.2 

Enable Audio If the destination server supports audio, click the 
checkbox to enable audio. 

Enable PDF If the destination server supports the PDF file format, 
click the checkbox to enable. 

Force to Single 
Series 

Click to take all the series residing in a study and send it 
as one large series. When the user sees it on the 
receiving end, it is one series. 
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Option Description 

Storage 
Commit 

If the destination server supports storage commit, click 
the checkbox to enable it. The additional menu items 
display: 

 

• Use Send Values – Duplicates the send to the server. 
Uncheck to create a unique video/image source. 

• TESTSC button – Tests the Storage Commit settings. 

Filter File 4. Click the text box below this Filters heading and 
start typing a filter you want to add. You are 
presented with a list of filter options. For example, 
if you typed the word thickness, you are presented 
with a variety of options that contain that word: 

 

5. Select the description you want to use as a filter. 

• You can add as many filters as required. 

6. Click OK when done. 

Remove Filters: Click the circle  icon to the left of 
the filter to delete it. 

Edit Filters: Click the pencil  icon next to the filter 
name and then click the icon again to edit. Make your 
changes and click OK when done. 

Delete Filters: Click the trash can  icon and then click 
it again to delete a filter from the worklist. 

 

3. Before you save the settings, you must test your entries: 

• If you enabled Storage Commit, click the TESTSC button. If the test is successful, 

you receive a message that the test completed successfully at the top of the 

page. 
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If the test is not successful, you receive an error message, check your settings 

and then click TESTSC again. An example message is shown below: 

 

• For the DICOM Send settings, click the TEST SEND button. If the test is 

successful, you receive a message that the test completed successfully at the 

top of the page. 

 

 
If the test is not successful, you receive an error message, check your settings 

and then click TEST SEND again. An example message is show below: 

 
 

4. Click OK to save after the test(s) succeed. 
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Edit a DICOM Server 

To edit a DICOM Server on TIMS MVP: 

1. Select the DICOM server you want to edit. 

 

2. Click the Edit  icon. 

3. Edit the settings for the selected DICOM server. For details on each setting, go to step 2 

in Add a DICOM Send Server on page 58. 

4. When have completed making edits to the selected DICOM server settings, you must 

test your changes: 

• If you enabled Storage Commit, click the TESTSC button. If the test is successful, 

you receive a message that the test completed successfully at the top of the 

page. 

 
If the test is not successful, you receive an error message, check your settings 

and then click TESTSC again. An example message is shown below: 

 

• For the DICOM Send settings, click the TEST SEND button. If the test is 

successful, you receive a message that the test completed successfully at the 

top of the page. 
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• If the test is not successful, you receive an error message, check your settings 

and then click TEST SEND again. An example message is show below: 

 

 
 

5. Click OK to save after the test(s) succeed. 
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Delete a DICOM Server 

To delete a DICOM server: 

1. Select the DICOM server you want to delete from the menu. 

 

2. Click the Delete icon (minus sign) below the list of DICOM servers to delete the selected 

channel. 

3. Click OK to confirm you want to permanently delete the DICOM server when you 

receive the prompt. 

 

Result: The DICOM server is removed from the list of servers. 
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Duplicate the Settings for a DICOM Server 

To duplicate the settings from an existing DICOM server on the menu: 

1. Select the DICOM server you want to duplicate from the list of channels. 

 

2. Click the Duplicate  icon. The DICOM Send page opens.  

 

3. Enter a new unique name in the Name field at the top of the page. 
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4. Make any required edits needed for the new DICOM server. 

Note: Go to step 2 in Add a DICOM Send Server on page 58 for a description of the 

DICOM Send fields 

5. Click OK when done. The new DICOM server appears in the DICOM Servers list. 

Configuring DICOM Query/Retrieve 

A DICOM Query/Retrieve operation retrieves images from remote DICOM servers in order to 

store them locally. After the images have been received, they can be loaded and processed 

independently of the remote server.  

This configuration option lets you: 

• Enable query/retrieve 

• Add a query/retrieve server 

To access these configuration options: 

1. Go to Help and select Configuration. The TIMS MVP Config dialog opens. 

 

 

2. Use the right arrow to move to display the DICOM Q/R tab. 

 

 



                      Getting Started  

68                                                                                                      TIMS MVP Setup and Configuration Guide 

3. Click the DICOM Q/R to display the configuration options. 

 

 

Enable Query/Retrieve 

• Click the Enable Query/Retrieve checkbox to enable query and retrieve images from a 

server. 

 

Result: The configuration options for DICOM Query/Retrieve display. 
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Add a DICOM Query/Retrieve Server 

To add a query/retrieve server: 

1. Click the + sign to add a query/retrieve server. 

 

Result: The Query/Retrieve Info dialog appears. 

2. Complete the fields in the DICOM Send page using the table below. 

 

 
 

Option Description 

Name Type in the name of the Service Class Provider (SCP).  

SCP AE Title Type in a name for the Service Class Provider (SCP Title of the 

DICOM query/retrieve system. 

SCP IP Address Enter the SCP IP address for the DICOM query/retrieve system. 

SCP Port Enter the SCP port for the DICOM query/retrieve system. 

Patient Name Encoding Select the patient name encoding you want to use for the 

query/receive server: 

• None (default) 

• Long First name 

• Long Middle Name 

• Long First Name End 
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Option Description 

• Long Middle Name End 

Use for Retrieval 

Settings 

• When unchecked, the query server options are used for 

retrieving images. 

• When checked, enter the options for the image retrieval 

server: 

 

 

o Remote AE Title: Type in a name for the remote 

Application Entity (AE) Title of the DICOM retrieval 

system. 

o Remote Port: Enter the port number for the 

retrieval system. 

 

3. Before you save the settings, you must test your entries: 

a. You need to test the query/retrieval settings or the query server settings if the 

Use for Retrieval Settings option is unchecked by clicking the Test button.  If the 

test is successful, you receive a message that the test completed successfully at 

the top of the page. 

 
 

If the test is not successful, you receive an error message, check your settings 

and then click TESTSC again. An example message is shown below: 

 
 

b. If you did not check the Use for Retrieval Settings checkbox, click the second 

Send button below the separate retrieval options. 

If the test is not successful, you receive an error message, check your settings 

and then click TEST SEND again. 

4. Click OK to save after the test(s) succeed. 

Edit a DICOM Query/Retrieve Server 

To edit a DICOM Server on TIMS MVP: 
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1. Select the DICOM query/retrieve server you want to edit. 

2. Click the Edit  icon. 

3. Edit the settings for the selected DICOM server. For details on each setting, go to step 2 

in Add a DICOM Query/Retrieve Server on page 69. 

 

4. When have completed making edits to the selected DICOM query/retrieve server 

settings, you must test your changes: 

• You need to test the query/retrieval settings or the query server settings if the 

Use for Retrieval Settings option is checked by clicking the Test button. If the 

test is successful, you receive a message that the test completed successfully at 

the top of the page. 

 
 

If the test is not successful, you receive an error message, check your settings 

and then click TEST again. An example message is shown below: 

 

• If you did not check the Use for Retrieval Settings checkbox, click the second 

Send button below the separate retrieval options. If the test is successful, you 

receive a message that the test completed successfully at the top of the page. 

• If the test is not successful, you receive an error message, check your settings 

and then click TEST again.  

 

5. Click OK to save after the test(s) succeed. 
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Delete a DICOM Query/Retrieve Server 

To delete a DICOM DICOM Query/Retrieve server: 

1. Select the DICOM server you want to delete from the menu. 

2. Click the Delete icon (minus sign) below the list of DICOM servers to delete the selected 

channel. 

3. Click OK to confirm you want to permanently delete the DICOM server when you 

receive the prompt. 

 

Result: The DICOM server is removed from the list of servers. 

Duplicate the Settings for a DICOM Query/Retrieve Server 

To duplicate the settings from an existing DICOM server on the menu: 

1. Select the DICOM server you want to duplicate from the list of channels. 

2. Click the Duplicate  icon. The DICOM Send page opens.  
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3. Enter a new unique name in the Name field at the top of the page. 

 

 

4. Make any required edits needed for the new DICOM server. 

Note: Go to step 2 in Add a DICOM Query/Retrieve Server on page 69 for a description 

of the DICOM Send fields 

5. Click OK when done. The new DICOM server appears in the DICOM Servers list. 

 

 

 

 



                      Advanced Settings  

74                                                                                                      TIMS MVP Setup and Configuration Guide 

Advanced Settings 

Labels for Series Description Tags 

The Labels tab on the Configuration page lets you provide a series description name and a series 

description label. 

You or an administrator (if you are not authorized to do so) can predefine series description 

labels that will be applied automatically for a particular channel. This is useful when you 

generally apply the same operational sequence with a particular modality.  

• A sample label list name is provided as MBSImp. 

• A Defaults label is provided which contains a selection of predefined series description 

tags 

To access the series description labels: 

1. Click the Help menu and select Configuration. 

 

2. From the TIMS MVP Config page, click the Labels tab. 
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Result: The Labels page opens. 

 

Add a Series Description Name and Label 

To add a series description name and label: 

1. Click  to add a Label. 

 



                      Advanced Settings  

76                                                                                                      TIMS MVP Setup and Configuration Guide 

2. Type in a Label List Name. 

 

3. Select a series label from the drop-down menu. You can scroll through the list to find 

the label you need. 
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For example, select Thin Liquid – Rapid Cups. It appears underneath the label list name. 

 

4. To add additional labels to your label list name, move the mouse over to the right of the 

label you just added and click the plus  sign. 

 
 

For example, select Nectar Thick – Rapid Cups. This selection displays underneath the 

first label you added. 

 

Remove a label: If you decide that you need to remove a label, move your mouse to the 

left of the label you want to delete. Click the minus sign to remove it. 

 

 
 

Change the label: If you need to change your label selection, move your mouse to the 

right of the label you want to change. Click the X to display the drop-down menu of 

labels and make a new selection. 
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5. Add additional labels, as needed. When you have made all your selections, click OK. The 

new list name displays on the Labels home page. 

 

Edit a Label 

To edit a label: 

1. Select the Label you want to edit. 

 

2. Click the Edit  icon. The Label Editor displays. 
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3. Edit the label by: 

• Add a label: To add a label, move your mouse to the right of an existing label. 

click the plus  sign. Use the drop-down menu to select a label. 

• Remove a label: To remove a label, move your mouse to the left of the label 

you want to delete. Click the minus sign to remove it. 

 

 

• Change the label: To change your label selection, move your mouse to the right 

of the label you want to change. Click the X to display the drop-down menu of 

labels and make a new selection. 

 

 

4. Click OK to save your edits. 

Delete a Label 

To delete a label: 

1. Select the label you want to delete from the menu. 
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2. Click the Delete icon (minus sign) below the list of Labels to delete the selected label. 

 

 

3. Click OK to confirm you want to permanently delete the label when you receive the 

prompt. 

 

 

Result: The label is removed from the list of labels. 
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Duplicate a Label 

To duplicate a label: 

1. Select the label you want to duplicate from the list of labels. 

 

2. Click the Duplicate  icon. The Label Editor opens.  

 

 

3. Enter a new unique label name in the Name field at the top of the page. 

 

 

• Make any required changes needed for the new label. 

Add a label: To add a label, move your mouse to the right of an existing label. 

click the plus  sign. Use the drop-down menu to select a label. 

• Remove a label: To remove a label, move your mouse to the left of the label 

you want to delete. Click the minus sign to remove it. 

• Change the label: To change your label selection, move your mouse to the right 

of the label you want to change. Click the X to display the drop-down menu of 

labels and make a new selection. 
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4. Click OK when done. The new label appears in the Labels list. 

 

 

Windows Active Directory 

This feature allows the site administrator to enable or disable the ability of users to access the 

TIMS MVP and TIMS Review application. 

System Requirements for TIMS Review 

• A domain client for the TIMS MVP system. 

• A domain client for Windows 10 TIMS Review computer. 

• Administrative rights to the TIMS MVP system and/or TIMS Review workstation. 

Configuring the Active Directory Server 

On the Active Directory Server: 

1. Create a group for TIMS MVP application access: 

(Example group: TIMS_PERMISSION_RUN) 

2. Add the desired TIMS MVP individual domain users to the group. 

NOTE: Be sure to add the Domain Administrator to the Group as well. 
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Access Active Directory TIMS MVP configuration page 

Use Active Directory to encrypt calls that contain user and password information. The 

encryption services included in Windows NTLM are used for this purpose. The encryption of 

authentication information is enabled by default. 

To access the TIMS MVP Active Directory configuration page: 

1. Start TIMS MVP.  

2. From the Help menu, select Configuration. 

: 

 

3. Login into the Configuration page as administrator and click OK. 

 

4. On the Configuration page, select the Active Directory tab. The Active Directory page 

appears. 
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Configuring Active Directory 

To configure Active Directory: 

1. To enable Active Directory Permissions, click the checkbox. The Active Directory options 

appear. 

 

2. On the Active Directory page: 

• Enter the Base DN (Domain Name). Enter the DC (Domain Controller & Extension) in 

the following format:  dc=DomainController,dc=Extension 

(comma separator and no space) 

• Enter the Server/IP Address 

• Enter the (LDAP) Port Number for access.  

Note: Ensure the port is open on the local firewall and server. 

3. Enter the User Group Name, for example: TIMS-USERS. 

4. Click the checkbox if you want to create an Admin Group. 

 

5. Enter the Admin Group Name, for example: TIMS-ADMIN. 

6. Before you can save the settings, you must validate your entries. See Active Directory 

Tests for Admin and User Groups on page 85.  
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Active Directory Tests for Admin and User Groups 

You can validate the TIMS MVP users or the administrator group from the Active Directory 

home tab. You will press the test button to conduct the validation. 

IMPORTANT: You must conduct a test before you can click Apply or OK to save your settings. 

To conduct a test: 

1. Click the test you want to perform – TEST USERS or TEST ADMINS. 

 

 

2. Login in to Active Directory. 

 

  



                      Advanced Settings  

86                                                                                                      TIMS MVP Setup and Configuration Guide 

3. Click Login. The test begins. 

• If the test is successful, you receive a success message. 

 

• If the test is not successful, you receive an error message above the Active Directory 

home page. You must edit your settings and test again. 

4. Once the test is successful, click Apply or OK to save the settings.  
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Configuring Security 

Change the Administrator Password 

The TIMS MVP Administrator (Admin) password is the master password for the TIMS MVP 

software. (It is not related to the Windows Administrator password.)  

The default password is: admin 

Set the Admin Password 

To set the Admin password: 

1. From the Help menu, select Configuration. 

 

2. Enter the Administrator Password and click OK.  

Make sure you do not have Caps Lock on when typing the password. 

         

If you are using the default password admin, a message appears recommending you change 

the password. Click OK. 
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3. Select the General tab on the TIMS MVP Config page. 
 

 

4. Click NEW ADMIN PASSWORD…. The Administrator dialog appears.

 

5. Type in the New Password and then type it in again in Repeat New Password. Click OK.  

 

Result: You have changed the admin password.  

 

NOTE:  If you do not type the same password in the Repeat New Password field, 

you receive a message that there is a password mis-match. Retype the 

password and click OK. 
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Configuring the Study Lists 

The study lists are lists which provide patient information details in a list from which you can 

choose a patient. 

When you access the TIMS MVP study worklist, it has a list of study information columns where 

you can either use TIMS MVP defaults or select your own fields. 

 

Select Fields for the Study Dashboard 

Use the Study Columns button on the TIMS MVP Config General page to select columns that are 

used on the Study Dashboard. 

1. Click the Help menu and select Configuration. 

 

2. From the TIMS MVP Config page, if not selected, click the General tab. 
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3. Click STUDY COLUMNS… button. The Study List Columns dialog appears. 

 

  

By default, the following headings are selected:  

Use the Study List columns dialog to: Last (Name), 

First, DOB, G (Gender), Study Date. Patient ID, 

Referring (Physician), Performing, Modality, Body 

Part, Acc# (Account number), Series, Size (Mb) 

and Keywords. 

• Click the checkbox to add any additional 

column headings you want to appear in the 

Study Dashboard.   

• Uncheck a checkbox if you want to remove 

a column heading. 

• Click Reset to reset the Study List Columns 

to the original defaults listed above. 

• Click OK to save changes. 

• Click Cancel to cancel changes. 
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When you open a study in TIMS MVP, the Study Dashboard appears with the study columns you 

selected. 

 

Purging Old Studies 

By selecting a percentage, you indicate when new studies are saved, the oldest studies are 

deleted to maintain disk usage below the specified percentage. You can select a percentage 

from 5 to 25 percent from the drop-down menu. Use the slider to select the percentage you 

want. Use the TIMS MVP Config General page to set the free space threshold for studies. 

To select a percentage: 

1. Click the checkbox OLD STUDY PURGE to set a free space threshold. 

 

2. Move the slide bar to select the percentage, the default is 10%. 

 

3. Click OK if you are finished with General settings. 
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Changing the TIMS MVP Studies Directory 

The default studies data folder for TIMS MVP is C:\ProgramData\TIMS MVP\TIMSDATA. Use 

the TIMS MVP Config General page to change the location of the data folder. 

To change the location of the data folder: 

1. Click the folder   icon next to the (Default Location). 

 

2. When the message to select a new drive appears, click OK. 

 

3. Browse for the new folder location, click the Select Folder button to change the 

directory location. 

4. Click OK to confirm the new study data location. 

 
 

Result: A white circle will display temporarily as the studies are moved to the new 

location. Once the circle stops, all existing and future studies will be saved to the new 

default study location. 
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Import and Export TIMS MVP Configuration File 

• Export your configuration to a file as a backup or to use with another TIMS MVP system. 

• Import a configuration file to use with your TIMS MVP. 

Export Configuration 

1. Click the Help menu and select Configuration. 

 

2. From the TIMS MVP Config page, if not selected, click the General tab. 

 

3. Click the EXPORT CONFIG button. A Windows dialog opens. 

4. Accept the default file name (settings-archive.mvp_settings), or, if you have multiple 

configuration files saved, type in a unique name for the file which makes it easy to 

identify. 

Note: You can also browse for a new folder location to place your file. 

5. Click Export Config and the file is saved to the TIMS MVP computer. 
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Import Configuration 

1. Click the Help menu and select Configuration. 

 

2. From the TIMS MVP Config page, if not selected, click the General tab. 

 

3. Click IMPORT CONFIG button. A Windows dialog opens. 

4. Browse to locate the file you want to import. When you locate the file, click to select it. 

 

Note: You can only import files to TIMS MVP with a *.mvp_settings extension. 

5. Click Import Config and the configuration is placed on the TIMS MVP system. 

It is recommended you check the settings imported to ensure the file imported 

correctly. 
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Retain Worklist UID Received from MVP 

You can retain a worklist Unique Identifier (UID) so that you can carry the hospital worklist UID 

into the study. This means when a Worklist UID is transferred to a PACS or TIMS Review, it will 

still maintain the original UID from the worklist. 

Otherwise, a UID is generated when the study is pulled from the worklist.  

To retain a Worklist UID received from TIMS MVP: 

1. Click the Help menu and select Configuration. 

 

 

2. From the TIMS MVP Config page, if not selected, click the General tab. 

 

 

3. Click the checkbox to select Retain Worklist UID Received from MVP. 
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Migrate TIMS3 Config 

Migration will replace the current settings of TIMS MVP with settings exported from the TIMS3 

Migration Utility.  You should export your current TIMS MVP settings using Export Config if you 

would like to be able to restore them. 

Export TIMS MVP Current Settings 

To export the TIMS MVP current settings: 

• Go Windows Start > TIMS3 Migration Utility > Migrate TIMS3. 

 

 

• The TIMS3 Migration Utility saves the current TIMS MVP settings. 

 

 

• The folder where the TIMS MVP settings migration was saved displays. 
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Migrate TIMS3 Settings 

To migrate the TIMS3 settings: 

1. Open TIMS MVP and go to Help > Configuration. 

2. Type in the administrator password when the Administrator login screen appears. 

 

 

3. Click OK. 

Result: The TIMS MVP Config page appears. 

 

 

4. Click the Migrate TIMS3 Config button in the lower left-hand corner. 

 

 

Result: The Migrate Configuration dialog appears. 
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5. Click the Select An Un-Zipped Migration Folder From TIMS 3 Migration button. 

 

 

Result: The folder which contains the TIMS3 migration files open. 

6. Select the unzipped migration file and click Select Folder. 

 

 
 

Result: The Migrate Configuration page displays with the Preflight tab selected. This tab 

contains the migration summary. 

 

IMPORTANT: If the Migrate Configuration page opens to the Resolve Conflicts tab, then 

review the conflicts and make any necessary changes. 
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7. Review the migration summary and click OK. 
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8. When the Replace Configuration? (Requires System Reboot) message appears, click the 

Confirm checkbox. 

 

 

                                                                            

9. Click Yes to start the migration. 

Result: A message appears telling you that the system will reboot in less than one 

minute. Click Close. 

 

 

10. Once the reboot is completed, you can reopen TIMS MVP with the migrated settings. 

 

Select Region for Date and Time Settings 

The Generable tab in the TIMS MVP Config page lets you choose the country or region for your 

location. This allows the date and time to appear in the proper format for your part of the 

world. 

To select a region: 

1. Select the General tab on the TIMS MVP Config page.. 
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2. Click on Region in the lower right-hand corner. 

 

 

3. From the drop-down menu, scroll through and select the region that is most appropriate 

for your location. The date and time format will match the format used for your region. 
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Creating a Custom Hardware Profile 
The remainder of this Setup and Configuration Guide provides step-by-step instructions for 

creating a custom hardware profile for the modality you will be using with TIMS MVP. Although 

TIMS MVP provides predefined common hardware profiles (CHP) files for its AccuStream 

capture boards, you are recommended always to create your own customized profile. This 

profile will ensure you obtain an optimized video stream. 

Using IDEA Auto-SYNC 

The IDEA Auto-SYNC application generates a preliminary set of video settings and allows you to 

customize these settings. You may return to IDEA Auto-SYNC at any time to manipulate your 

custom hardware profile further. Included with IDEA Auto-Sync are example programs that use 

the profile you create with IDEA Auto-SYNC and allow you to perform image captures and other 

functions to test the profile. 

Image Requirements 

When generating a new CHP file with IDEA Auto-SYNC, best results are obtained if the colored 

pixels of the image to be measured fill the entire width and height, or at least parts of it extend 

to the boundaries of the active video region. Medium to bright pixels at the edges are best. The 

signal should also contain the maximum amount of contrast between black and white. The 

image should remain stable during the entire operation of IDEA Auto-SYNC. 

Limitations 

IDEA Auto-SYNC looks at both sync and video signal data. The video portion of the signals must 

contain an image that meets certain criteria. If those criteria are not met, the CHP file generated 

by Auto-SYNC will not be correct and the image captured with it will be inferior. The image 

criteria along with a description of the effect of captured image, if the criteria are not met, are 

listed here: 

1. At least 1% of the image must be the brightest white. 

Or else: IDEA Auto-SYNC will underestimate brightest white. Images will be too bright 

and have too much contrast. 

2. At least 1% of the image must be the darkest black. 

Or else: IDEA Auto-SYNC will overestimate darkest black. Images will be too dark and 

have too much contrast. 
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3. Light (50% gray or whiter) portions of the image must touch all four sides of the image. 

Or else: IDEA Auto-SYNC may fail to recognize image boundaries. Images will be clipped 

or there may be no image capture at all. 

4. Wide solid black (3% gray or blacker) bars stretching across the entire image in any 

direction should be avoided. 

Or else: If composite video is not being used, the stripes may mimic composite sync 

information. IDEA Auto-SYNC is very resistant to this type of mistake but not completely 

immune to it. Images will appear scrambled. 

5. Include many edges (as with text, fine stripes or a checker pattern). 

In addition to the criteria listed above, future enhancements to IDEA  

Auto-SYNC may be able to take advantage of other image characteristics. If you are developing a 

standard test pattern for IDEA Auto-SYNC for long-term use, the pattern should include sharp 

pixel transitions from light to dark and dark to light. A pixel transition is considered "sharp" if the 

change in gray-scale from one pixel to the next (to the left or right) exceeds 50% of the full black 

to white range. Including test or vertical or near-vertical fine grill patterns in the image would 

suit the purpose. 
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Using IDEA Auto-SYNC 

Using Auto-SYNC provides the following capabilities: 

• Allows you to configure to any modality/video source. 

• Creates video configuration files for use in TIMS MVP or with 

the IDEA SDK applications. 

• Automatically measures and defines video parameters. 

• Provides Auto-SYNC procedures for SDTV and Analog RGB/Monochrome. 

The following is a brief description of each toolbar icon in Auto-SYNC: 

         

Create a 

new CHP 

file 

Open CHP 

file 

Save CHP 

file 

Open 

video 

settings 

Open 

Auto-SYNC 

Wizard 

Refresh 

images 

Continuously 

capture 

(full-size 

view) 

         

         

Multi-

view 

window 

 

Full 

window 

Previous 

window 

Next 

window 

Show 

combined 

RGB 

view 

Automatic 

phase 

White 

balance 

Reset 

board 

 

The following toolbar icons are used for combined RGB views: 

        

Edit Red, 

Green, 

Blue 

channel 

Link RGB 

CHP 

changes 

Reset RGB 

HTotal and 

porch 

settings 

Reset 

RGB 

image 

size 
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The following table lists the hot keys available while using IDEA Auto-SYNC: 

Hot Key Description 

<Alt> + <F10> Continuous capture in full-size view 

<Ctrl> + <A> Open video settings 

<Ctrl> + <N> New CHP file 

<Ctrl> + <O> Open CHP file 

<Ctrl> + <S> Save CHP file 

<Ctrl> + <W> Open Auto-SYNC Wizard 

<F4> Automated image refresh 

<F5> Refresh images now 

<F7> Always verify video settings 

<F8> Step 

<F9> Multi-view window 

<F10> New full-size image window 

CTRL+HOME Show upper left corner of Auto-SYNC 

CTRL+END Show lower left corner of Auto-SYNC 

CTRL+PGUP Show upper right corner of Auto-SYNC 

CTRL+PGDOWN Show lower right corner of Auto-SYNC 

SHIFT+Left Arrow Show left edge of Auto-SYNC 

SHIFT+Right Arrow Show right edge of Auto-SYNC 

SHIFT+Up Arrow Show top edge of Auto-SYNC 

SHIFT+Down Arrow Show bottom edge of Auto-SYNC 

CTRL+Left Arrow Move Auto-SYNC window left (small) 

SHIFT+Left Arrow Move Auto-SYNC window left (large) 

CTRL+Right Arrow Move Auto-SYNC window right (small) 

SHIFT+Right Arrow Move Auto-SYNC window right (large) 

CTRL+Up Arrow Move Auto-SYNC window up (small) 

SHIFT+Up Arrow Move Auto-SYNC window up (large) 

CTRL+Down Arrow Move Auto-SYNC window down (small) 

SHIFT+Down Arrow Move Auto-SYNC window down (large) 

CTRL+HOME Show upper left corner of Auto-SYNC 
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Hot Key Description 

CTRL+END Show lower left corner of Auto-SYNC 

CTRL+PGUP Show upper right corner of Auto-SYNC 

CTRL+PGDOWN Show lower right corner of Auto-SYNC 

Starting IDEA Auto-SYNC 

To start IDEA Auto-SYNC, select Start > Foresight Imaging > Auto-SYNC icon from the Start 

menu. 

 

The application opens and is ready to begin the IDEA Auto-SYNC process. The Getting Started 

With Auto-SYNC dialog opens.  

 

Figure 1: IDEA Auto-SYNC opening screen. 

Recommended Calibration Images  

When the Getting Started With Auto-SYNC dialog appears, click the Recommended Settings 

button in order to learn about the Auto-SYNC operations to perform with specific calibration 

images. You can choose from four operations: 



Creating a Custom Hardware Profile 

TIMS MVP Setup and Configuration Guide                                                                                               107  

 

Figure 2: Recommended Calibration Images dialog. 

Text Pattern – The text pattern is usually a page 

of white on black text. The font should be small 

and narrow to maximize the dark-to-light 

transitions. A text pattern is useful for 

calibrating the HTotal, Phase Delay, and 

Brightness/Contrast. See calibration example in 

the above dialog. 
 

Grill Pattern – The grill pattern is a series of 

alternating black and white vertical bars (down 

to one or two pixels in width) are the most 

useful for calibration. The grill pattern provides 

a high contrast image with its sharp dark-to-light 

transitions and is most useful for adjusting the 

Phase Delay. 
 

Linearity Pattern – The linearity pattern is an 

image with white vertical and horizontal lines 

plus concentric circles against a black 

background. The pattern’s circles are ideal for 

calibrating the HTotal and setting the Field 

Polarity. Its high contrast and range are useful 

for setting Phase Delay and Brightness/Contrast. 
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SMPTE Pattern - The SMPTE pattern is a 

standard video calibration image with a variety 

of gray levels, shapes, and lines. It has a full-

screen background. This is a good pattern for a 

new Auto-SYNC session. The pattern’s shapes 

and grayscale boxes are not useful for 

calibrating HTotal and the Brightness/Contrast. 

Its full-screen gray background makes it ideal for 

setting the image framing and the Vertical Sync 

Type. Its diagonal lines and text are useful for 

setting the Field Polarity. 

 

To close the Recommended Calibration Images dialog, click the red X in the top right hand 

corner. 

Note:  For the best Auto-SYNC accuracy and since In the real world a video  

generator is not always available, it is best to display an image that will be representative of 

what you are trying to capture with the frame grabber.  

Creating CHP Files 

IDEA Auto-SYNC allows users to create new Common Hardware Profile (CHP) files or tailor 

existing CHP files for your computer system. For AccuStream boards, Auto-SYNC generates a 

new CHP file based on the particular signal characteristics. 

Location of CHP Files 

The location of the CHP file will vary depending on your installation.  
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Windows 10 (64-bit) Installation 

If you are doing a Windows 10 installation, the CHP files are saved to the \Users\Public\Public 

Documents\Foresight\Video Formats folder. 

 

Figure 3: Location of CHP files on Windows 10 

Using Auto-SYNC Advanced Options 

Click Advanced on the New Auto-SYNC Session dialog and the following screen options appear. 

 

Figure 4: Advanced Button 

Click Advanced to set the following options: 

Log Report Generation options, 

and, advanced Video calibration 

options appear when you click 

the Advanced button. It is 

recommended you keep the 

defaults. 
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Log Report Generation: Sets the base filename for output log file. The file is created in the CHP 

file folder using incremental filenames. 

Open Combined RGB Output View: If three monochrome video channels are detected, Auto-

SYNC will attempt to open them as a combined RGB image.  No longer supported.  

Originally used with the Hi-Def Series frame grabbers. 

No Stray Syncs Allowed: Auto-SYNC allows a small number of stray syncs to be processed 

without causing an error, but the presence of any stray sync pulses can be rejected by enabling 

this feature. 
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Blanking Filter: The blanking filter specifies the number of lines at the top and bottom of the 

image to ‘ignore’ during the calculations of an Auto-SYNC session. 

This is used when the source has some ‘video aberrations’ at the top and bottom of the signal. 

▪ Video Format Filter: Video format filters define the preferred aspect ratios for video. 

The selections include: 

▪ None (Default) 

▪ VESA/VGA 

▪ HDTV 

▪ Custom 

After an initial Auto-SYNC session, if the Aspect Ratio of the image is distorted (for 

example, circles in the image are extremely elliptical -- horizontally or vertically), a 

custom aspect ratio value can be used to provide better Auto-SYNC results.   

 

When Auto-SYNCing to medical modalities such as 512 x 512 or  

1K x 1K video, Auto-SYNC yields better results when the aspect ratio of 1:1 is entered as 

a custom format filter.  

 

Example: To set a preferred 1:1 aspect ratio session: 

 

 

Figure 5: Custom format filter 

Note:  It is recommended that you do not change these settings unless you have the 

experience and knowledge to do so. 
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Two Methods for Creating CHP File 

IDEA Auto-SYNC provides two methods for creating a new CHP file: Automatic (Express) and 

Interactive (OK). Both methods create an initial CHP with video settings appropriate for your 

computer system. Once this initial file is created, you then have the option to make additional 

changes or exit the program. The “Interactive” method allows additional editing of the video 

settings during the creation of the initial CHP file. 

Note: If you are interested in specific information concerning the IDEA Auto-SYNC settings, 

please refer to the appropriate CHP settings in Chapter 5, Understanding the CHP File. 

Automatic 

Click Express. This automatically adjusts all of the settings for you. You can make 

modifications once the initial settings are defined. 

Interactive 

Click OK. As IDEA Auto-SYNC checks or verifies some of the settings, you are given the 

option to examine and possibly modify the settings. 

Next Step: Run Auto-SYNC for the Input Connection 

Go to the chapter which covers the type of input connection you will be using with your 

AccuStream Board: 

For digital input connections. Go to page 177. 

For SDTV input connection. Go to page 208 
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IDEA Auto-SYNC with RGB/VGA/DVI Analog Video  

Select the Connection Type 

Video Input Selection 

DVI-I Connector: Monochrome/RGB/VGA/DVI Analog 

non standard high resolution video 

connected to the DVI input 

connection. 

DVI-D Connector: DVI-Digital or HDMI Digital video 

source connected to the frame 

grabber HDMI connector. 

S-Video or Composite 

BNC: 

Standard NTSC/Pal Svideo or 

Composite video. 

 

IDEA Auto-SYNC will first prompt you to identify the AccuStream board mode. Select the 

connection you have to the AccuStream board and then click OK. If you want to keep the 

selection as your default, click the checkbox below the connection selection so that this dialog 

does not appear again. 

 

Figure 6: AccuStream Input Connector 

 

Note: In this example the AccuStream Express HD+C is used. 

Video input selection option varies depending on the model frame grabber used.   

After you make your selection and click OK, the Hints dialog appears. It is recommended that 

you read the dialog and click OK. If you do not want this dialog to appear each time you start an 

Auto-SYNC session, uncheck the Always display hints before an Auto-SYNC session box. 

Analog input 

connector 
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Figure 7: Hints dialog 
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Next select the color space of the video source from the dropdown menu, standard RGB or 

YPbPr video or Monochrome. 

 

Figure 8: Select RGB, Monochrome or YPbPr video 

Auto-SYNC detects and determines the video source timing and measures the  

video source White and Black levels and phasing.  

 

 

Figure 9  Auto-Sync measuring the video source timings. 

 

At the completion of the Auto-SYNC calibration process Auto-SYNC may prompt for text 

comments for the CHP file. (Useful for including notes about the video source) 
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Figure 10: Comments on the CHP file 

Auto-SYNC finishes calibration and creates the CHP file Auto_CA1.chp. 

If the CHP file already exists you will be prompted to overwrite the file. 

When you click YES, Auto-SYNC will increment the default Auto-CA1.chp filename. 

 

Figure 11: Saving the CHP file  

 

  

Important:  

When saving the CHP file, provide a filename that you will easily recognize for your video 

source.  
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Auto-SYNC Wizard 

The main Auto-SYNC screen appears after entering the chp file comments. 

 
Figure 12: Start screen for the Auto-SYNC wizard 

When the Auto-SYNC wizard start page appears, 

1. Ensure that your PC monitor is properly calibrated and you are working in the same 
illumination as the system you will use.  

2. Use the Wizard calibration dialogs to help you determine what changes you need to 
make, if any.  
 
Use the Full Screen Capture icon and the Snap (F5) button to  
refresh the Auto-SYNC windows.  
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The Multi-View Window is used to aid in making the following adjustments:  

Image aspect ratio, Image Centering/Framing, Image Width, White and Black 

levels and frame grabber phasing adjustments. 

Full Frame is a scaled down image captured by the frame grabber. It is used to aid in adjusting 

overall image centering, image width and aspect ratio. 

A Select Region is zoomed in section of that image. It is used for checking image quality in 

selected areas of the image captured. 

The Logarithmic Histogram displays the images White and Black levels.  R,G,B, Grayscale 

selectable. 

 
 

Figure 13: Auto-SYNC Multi-View Window 

Note: Analog Images used in this example are captured from: 

         Standard computer using DVI Analog 1280x124-60Hz secondary output, 

         Quantum Data 802R DVI Analog and 802BT HDMI video generators set to  

         either 640x480, 1024x768 or 1280x1024 and also Toshiba S-video–1080P  

         up scaling DVD player. 
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Running the Auto-SYNC Wizard (Analog) 

Once the IDEA Auto-SYNC process has completed, the Auto-SYNC Wizard is automatically 

started to facilitate fine tuning of the video settings. The Auto-SYNC Wizard can be started 

manually at any time. 

To start the Auto-SYNC wizard, you can do one of the following: 

▪ Click the Skip Intro to skip the video calibration images information. The 3 page introduction 
provides basic information about image calibration and introduces the standard image types 
that are most useful when using the Auto-SYNC Wizard. To view details on the video 
calibration images, see Recommended Calibration Images on page 106. 

▪ To view the video calibration images information as part of the Auto-SYNC wizard, click 
Next. 

 
 

Figure 14: IDEA Auto-SYNC Wizard introductory screen once the CHP file is created 

Note: Quantum 802R set to DMT1260G format. 
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The Multi-view window displays multiple monochrome views of the image (zoom, histogram, 

etc.) and also displays the board type (and its serial number) that is being used. When using an 

AccuStream board, the Multi-view window can display either Y-only (luma) grayscale or one of 

the three RGB color planes. The figure also shows a full-size window that displays the entire 

image (with scroll bars, if needed). Both windows are useful when running the Auto-SYNC 

Wizard. 

 

 

Figure 15: IDEA Auto-SYNC Wizard Multi-view Window  

Every page of the Auto-SYNC Wizard includes a pair of Back/Next buttons for navigation; steps 

in the Auto-SYNC Wizard can be repeated as needed.  Convenient buttons to bring up the 

Histogram (in the multi-view window) or the Full-Size view window on the CHP file are available. 
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Auto-SYNC Wizard 

 

Figure 16: IDEA Auto-SYNC Wizard Information screen 

After viewing the Auto-SYNC Wizard introduction, the tuning process begins. There is a large 

button on the first introduction page that skips to the first tuning step. On the last introduction 

page is a checkbox that hides the introduction pages the next time the Wizard is used; the user 

can also enable/disable the introduction from Auto-SYNC’s Preferences menu. 

Note: The Auto-SYNC Wizard process varies slightly for different board types. 
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AccuStream Auto-SYNC Wizard Step 1: Adjust HTotal for Analog 

Connections 

The first step is to adjust the Horizontal Total (HTotal). The HTotal is the number of pixels per 

scan line in the video signal; some of these pixels are not part of the active video (e.g., porches 

which are on the right and left side of the image) so HTotal represents the active plus the 

inactive video signal measured as pixels. Increasing the HTotal widens the image which increases 

the aspect ratio.  

Note: Be aware of the monitor format (your display, for example, is it 4:3 / 5:4 or 16:9), before 

adjusting the HTotal. Your display monitor aspect ratio  

should be set to the same aspect ratio as the video source. 

 

       

Figure 17: Auto-SYNC Wizard Step 1 

HTotal adjustments require a video image that highlights errors in aspect ratio. An image with 

circles or squares or a text pattern is recommended. 

If your video is interlaced, look at the image to see if text or diagonal/curved lines appear 

ragged. If the text or lines do, try adjusting the Field Polarity to change the ordering of 

fields/frames. Depending on the video pattern, changes to the field ordering may have 

invalidated the results of the Auto-SYNC session. You may want to rerun Auto-SYNC to generate 

a new CHP file. 
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The HTotal is adjusted by typing a new value into the edit box or using the up/down buttons; the 

arrow and Page Up/Down keys also work. Changes to the HTotal are reflected in any open views 

of the CHP file (multi-view, full-size view). Focus on getting the aspect ratio correct; the image 

framing will be adjusted in a later step. 

Aspect Ratio (HTotal) Adjustment Example 

This first example shows a video image with the correct values for aspect ratio. Notice that the 

circle and square shapes are not distorted. Another good way to check aspect ratio is with text 

images. 

 

 

 

 

 

          Figure 18: Example of Aspect Ratio (HTotal) with Correct Values 

Verify that the shapes (or text) in the 

video image are not distorted. This 

ensures that the video image has the 

correct aspect ratio. 
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This next example shows a video image that is too narrow. You will notice in this 

example that the square and circle shapes are distorted vertically. The square and 

circle images are too narrow. 

 

 

 

 

 

 

Figure 19: Example of Aspect Ratio (HTotal) that needs a horizontal adjustment 

To correct the above example, change the HTOTAL value to a higher value by entering 

a higher number in the text box or using the up arrow key to change the value. Keep 

changing the value until the shapes appear correct. 

 

  

The next example shows a video image that is too wide. The shapes will have the same 

distortions as shown in the previous example, but horizontally. 

 

Notice the circle is oblong because it is 

too narrow, as well as, the squares have 

a rectangle shape. 
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Figure 20: Example of Aspect Ratio (HTotal) that needs a vertical adjustment 

  

Notice the circle is oblong because it is 

too wide, as well as, the squares have a 

rectangle shape. 
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To correct the above example, change the HTOTAL value to a lower number by entering a lower 

number in the field or using the down arrow key to change the value. Keep changing the value 

until the shapes appear correct. 

 

  

In this last example, you will see the aspect ratio distorted when viewing a video image with 

text. 

 

 

 

 

Figure 21: Example of Aspect Ratio with text that needs adjustment 

When text is distorted, it is recommended that you change the Field Polarity.  

 

  

Notice the distortion in this area of the text. 

The white letters are broken and skewed. 
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TIPS: 

Use the Histogram to view changes needed, if any. Use this Auto-SYNC step to make sure of 

the following: 

▪ Make changes to HTOTAL if you have issues with any of the following: 

Circles are not concentric 

Squares are not “square” 

Text is not even and consistent across 

Have fine vertical lines in the image. 

▪ Make aspect ratio adjustments through HTotal: 

Increase HTotal to widen image 

Decrease HTotal to narrow image 
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AccuStream Auto-SYNC Wizard Step 2: Adjust Phase Delay for 

Analog Connections 

The next step is to adjust the phase delay. The phase delay determines how the pixels 

in the video signal are sampled and acts as an offset to the pixel clock. When the 

phase is set correctly, the pixels are sampled at their peak values providing the best 

image quality. Sampling the pixels with the wrong phase offset can lead to poor 

results. 

 

Figure 22: Auto-SYNC Wizard Step 2 

Phase delay adjustments require a video image that has maximum horizontal contrast. 

An image with a grill pattern or high contrast text is recommended. 

The Phase Delay is adjusted in the standard way by typing a new value, using the 

up/down buttons, or using the arrow/Page Up/Page Down keys. The histogram window 

in the multi-view window can be especially helpful to see the effects of minor 

changes. 

The AccuStream boards support Fine Phase adjustment. There are 32 discrete phase 

values that allow finer tuning of the phase adjustments. 

Auto-SYNC will attempt to recalculate the optimal phase delay setting if you click the 

"Auto..." button. Auto-SYNC prompts for a selection of the phase determination 

algorithm; the algorithms are described earlier in this section. The phase 

determination algorithms vary in time to complete and thoroughness of testing and it 
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is recommended that the faster algorithms be used unless the results are not 

satisfactory. 

Example 

In the first example, a properly aligned video image is shown. Notice how the there is 

high contrast between the white text and black background with no distortions. This 

image is properly aligned.  

 

 

 

Figure 23: Example of text with good phase delay values 

Notice the clear delineation between the black and white pixels which 

indicates a properly aligned image with maximum contrast. 
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In the next example, you can see the contrast between the white text and black background is 

blurred. Black and white pixels are mixed which indicates that it is poorly aligned. 

 

 

 

Figure 24: Example of text that needs a phase delay adjustment 

It is recommended that you run Auto… first to see if this fixes the phase delay for the 

video image. If this does not you need to the phase delay but entering values in the 

Phase Delay text box or using the up/down arrows to change the value. 

Notice how there is less of 

delineation between the black 

and white pixels. 
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Tips: 

The following illustration phase delay properly aligned and poorly aligned. Use the Phase Delay 

Adjustment step to make adjustments if your image is not properly aligned. Also, see 

AccuStream Auto-SYNC Wizard Step 2: Adjust Phase Delay. 

  

 
 
Figure 25: Phase delay adjustment illustration of properly and poorly aligned images
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AccuStream Auto-SYNC Wizard Step 3: Adjust Left/Right Framing 

for Analog Connections 

The next step is to adjust the left/right framing of the image. The left edge is set first and then 

the image width. The left edge is set by the value of the Horizontal Back Sync (HBS), which 

represents the period between a horizontal sync pulse and the start of active video. The image 

width is set as the number of pixels per line. 

 

Figure 26: Auto-SYNC Wizard Step 3 

Framing adjustments require an image that has a non-black background that extends across the 

entire image. The SMPTE pattern is recommended. 

The Horizontal Back Sync (HBS) is adjusted in the standard way. Increasing the HBS moves the 

image to the left. Set the HBS so that the image’s background extends fully to the left of the 

viewing window. 

Once the HBS is set, the image width can be adjusted in the standard way until the full width of 

the image appears in the viewing window. Now that the full image width is visible, it is possible 

that the aspect ratio was incorrectly set in Step 1; click the <<Back button to go to Step 1 to fix 

it. 

Note:  When adjusting HBS, the number of pixels per line is adjusted so that the image extends 

to the left of the viewing window. 
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Example 

This first example shows a video image with the correct values for Left/Right Framing. 

Notice that both edges of the video image align against the edge; there is no distortion 

or clipping. 

 

 

Figure 27: Example of proper video image framing 
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In the next example, the video image is too large and is clipped on its left edge. 

 

 

 

 

Figure 28: Example of framing values too large 

To adjust the image, decrease the HBS value to move the image to the right. This 

adjustment will result in the whole image displaying without a clipped left edge.  

 

Notice that the left edge is 

clipped. This is because the 

image is incorrectly positioned. 
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In the next example, the video image is too small. The image is too far from the left 

edge. 

 

 

 

 

Figure 29: Example of framing values too small 

 

To adjust the image, increase the HBS value to move the image to the left edge.  

The image is too 

incorrectly positioned and 

is too far from the left 

edge. 
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In the next example, the image width is too small and needs to increase the width to 

the right edge. 

 

 

 

 

Figure 30: Example of video image that is not wide enough 

To adjust the video image, increase the image width to widen the image to the right 

edge. 

The image is clipped 

on the right side. The 

image needs to be 

widened to the 

right edge. 
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In the next example, the image width is too wide.  

 

 

 

 

Figure 31: Example of video image that is too wide  

To adjust the video image, decrease the image width to fit into the left and right 

edges. 

 

When the image is too large, 

the left edge is clipped and 

the right edge has a blank 

area. 
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TIPS: 

When making left/right framing adjustments: 

▪ Adjust the left edge with HBS – increase HBS moves image to left; decrease HBS moves 
image to right. 

Use to clip the image’s left side. 

Use to define horizontal Area of Interest (AOI) position. 

▪ Adjust the right edge with image width – increase width increases right edge; decrease 
width decreases the left edge. 

Use to clip right side of image. 

Use to define horizontal size of AOI. 
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AccuStream Auto-SYNC Wizard Step 4: Adjust Top/Bottom 

Framing for Analog Connections 

The next step is to adjust the top/bottom framing of the image. The top edge is set first and 

then the image height. The top edge is set by the value of the Vertical Back Porch (VBP), which 

represents the number of vertical blanking lines in the video signal from the trailing edge of the 

vertical sync to the start of active video. The image height is set as the number of lines in the 

image. 

 

Figure 32: Auto-SYNC Wizard Step 4 

Framing adjustments require an image that has a non-black background that extends image 

upward. Set the VBP so that the image’s background extends fully to the top of the viewing 

window. 

Once the VBP is set, the image width can be adjusted in the standard way until the full height of 

the image appears in the viewing window. 
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Examples 

In this example, the video image is too large and extends beyond the top edge. 

 

 

 

 

Figure 33: Example of video image that is clipped at the top edge 

To adjust the image, decrease the VBP to move the image down. This will align the 

video image to the top edge. 

The image is clipped at the top 

edge. The bottom edge is properly 

aligned. 
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In the next example, the video image is too small. The top edge is clipped and the 

bottom edge is above the bottom edge of the image. 

 

 

 

 

 

Figure 34: Example of video image that is clipped at the top edge and is not aligned with the bottom edge 

To adjust the image, increase the VBP to increase the size of the image. This will align 

the video image to the top edge. 

The top edge of the image is clipped 

and the bottom edge is not aligned. 



                      IDEA Auto-SYNC with RGB/VGA/DVI Analog Video  

142                                                                                                      TIMS MVP Setup and Configuration Guide 

In the next example, the video image is too small and is not reaching the bottom 

edge. 

 

 

 

Figure 35: Example of image that is too far from the bottom edge 

To adjust the image, increase the height to increase the bottom edge. This will align 

the video image to bottom edge. 

The image is not aligned to the 

bottom edge. 
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In the next example, the video image is too large and is distorted at the bottom edge. 

 

 

 

 

Figure 36: Example of video image that is not aligned to the bottom edge 

To adjust the image, decrease the height to decrease the bottom edge. This will align 

the video image to bottom edge. 

 

 

  

The image is too large and does not align 

to the bottom edge. 
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TIPS: 

When making top/bottom framing adjustments: 

▪ Adjust the top edge with VBP – increase VBP moves image up; decrease VBP moves image 
down. 

Use to clip the top of image 

Use to define vertical AOI position 

▪ Adjust bottom edge with height – increase height increases bottom edge; decrease height 
decreases bottom edge. 

Use to clip edge of image 

Use to define vertical size of AOI 

AccuStream Auto-SYNC Wizard Step 5: Adjust Brightness and 

Contrast for Analog Connections 

The next step is to adjust the brightness and contrast of the image. It is normal for the pixels to 

range from 0 to 254 to insure you’re not clipping the white or black pixels. The frame grabber’s 

maximum range is 0-255. 

 

Figure 37: Auto-SYNC Wizard Step 5 

Brightness and contrast adjustments require a video image that has the full black-to-white 

range. Images with a text pattern are recommended. The histogram is very useful for this step 

so the multi-view window is recommended. 
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Position the mouse over the blackest part of the image. Adjust the Brightness value in the 

standard way. Shifting the Brightness changes the pixel values; these changes are visible either 

in the pixel value reader (in the lower right of Auto-SYNC’s status bar) or in the histogram. The 

goal is to have the black pixels correspond to pixel values near 1. 

Once the Brightness is set, move the mouse to the whitest part of the image. Adjust the 

Contrast value until the white pixels correspond to values near 254. 

Changing the Contrast may affect the results of the Brightness adjustment, so this process must 

be repeated iteratively until the desired brightness and contrast are achieved. Watch the 

histogram to be sure that the range of pixel values extends from 0 to 254 and that not too many 

pixels are being mapped to these extremes (i.e., near-black is mapped to total black). 

Examples 

In this first example, the video image has the correct settings for the brightness and 

contrast. In this image, the mouse is moved to the black part image to show the value 

is correct at the 0,0,0 setting. For contrast, you would move the cursor over the white 

part of the image where the correct setting would be 255,255,255.  

 

 

Figure 38: Example of video image with proper settings for brightness and contrast 

This image has the proper settings for brightness and contrast. To 

determine if your settings are correct, move the mouse over the 

blackest part of the video image. It should display as shown below 

where black is indicated by a 0,0,0 setting. 
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In this next example, the black or brightness setting is set too low.  

 

 

 

 

Figure 39: Example of video image where the brightness (Black Level) is too dark 

  

Move the cursor over the area that you 

believe is set to the correct black value. 
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In order to adjust the setting, do the following: 

1. Click your mouse in the Brightness field. 

2. Move your mouse over the black area of the image until you find the value 0,0,0 in 
the bottom right hand corner. For example, in the screen example below, move 
the mouse to the black box labeled. 

3. Press the up arrow key once to see if the 0,0,0 value increases. If it does not 
increase above 0,0,0,  then the black value is set too low. Keep pressing the up 
arrow until you reach the next value above 0,0,0.  

4. Once you have reached the next value above 0,0,0, then use the down arrow to 
move back to the 0,0,0 value. The Brightness is now set properly 
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In this next example, the value for Black is set too high. This means when you move 

the mouse cursor over the area which you believe it is set to the correct Black value of 

0,0,0, it is higher than that value. In this example, you can see the value is set to 

0,3,9. 

 

                                             

Figure 40: Example of video image where the brightness setting (Black Level) is too high 
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To adjust this value to the correct value for Black, do the following: 

1. Click your mouse cursor over the Black field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (Black) value on the video 
image. 

3. Use the down arrow key to move the Brightness (for Black) setting to 0,0,0 
which is displayed in the bottom right hand corner. Stop pressing the arrow key 
as soon as you reach the 0,0,0 level since if you continue to press the key, the 
Black Level value will be set too low. 

The next example shows how to adjust the Contrast value when it is set too low. In 

this example, the Contrast is based on the white level should be set to 255,255,255.  
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Figure 41: Example of video image where the contrast (White Level) is set too low 

  

The mouse cursor must be positioned over the area 

considered to have the correct Contrast value of 

255,255, 255. This is white value. 

Notice below in the left hand corner the value is set too 

low. 
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To adjust this value, do the following: 

1. Click your mouse cursor over the Contrast field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (White) value on the video 
image. 

3. Use the up arrow key to move the Contrast setting to 255,255,255 which is 
displayed in the bottom right hand corner. Stop pressing the arrow key as soon 
as you reach the 255,255,255 level since if you continue to press the key, the 
Contrast value will be set too high for contrast. 

In this final example, the Contrast value is set too high. This means that even 

though it appears that the value is set to 255,255,255, it is really set above that 

value due to the lack of contrast with the surrounding white squares. 

 

 

 

 

Figure 42: Example of video image where the Contrast (White Level) is set too high

The contrast is set too high. This is determined by the fact 

that you cannot see any contrast with the surrounding 

white squares. 

Even though the setting is too high, the display in the lower 

right hand corner displays the maximum Contrast value. 
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To adjust the contrast value that is set too high, do the following: 

1. Click your mouse cursor over the Contrast field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (White) value on the video 
image which in this case is 255,255,255. 

3. Use the down arrow key to move the Contrast setting to the next value below 
255,255,255 which is displayed in the bottom right hand corner. Stop pressing 
the arrow key as soon as you reach the first value below 255,255,255. 

4. Use the up arrow to return to the next value up, which should be 255,255,255. 
The Contrast is now properly set.  

Tips: 

When making Brightness/Contrast adjustments: 

▪ Have the pixel reader in Full Window mode. 

▪ Have the Histogram in Quad Window mode. 

▪ Adjust Brightness for the level of Black. 

▪ Adjust Contrast for level of White. 

▪ Ensure Brightness/Contrast is not clipped. 
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AccuStream Auto-SYNC Wizard Step 6: Adjust Miscellaneous 

Settings for Analog Connections 

The final step of the Auto-SYNC Wizard attempts to correct some basic problems that can occur 

with some video signals. 

 

Figure 43: Auto-SYNC Wizard Step 6 

A full-size view on an image that has content along the top edge and contains some diagonal 

lines or text is recommended; the SMPTE or linearity patterns are ideal. 
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If diagonal lines appear unusually ragged or text in the image appears broken (“shaken”), change 
the Field Polarity value. This adjusts the order in which the fields of the image are assembled 
and reverses the ordering of adjacent scan lines in the video. 

If there appears to be some twisting at the top edge of the image, the Vertical Sync Type may 
need to be adjusted from “Normal” to “Block” or “Extended Block”. 

The user can run the White Balance procedure to adjust the red, green, and blue channel gain 
and offset compensation values for the particular source to assure that pure white and pure 
black are properly calibrated. White balancing should be performed when the video source 
changes. 

Click the Finish button to complete the Auto-SYNC Wizard process. You can restart the 
Auto-SYNC Wizard at anytime by selecting a CHP file and clicking the Auto-SYNC Wizard toolbar 
icon or by selecting the View > Auto-SYNC Wizard menu item. 

Example 

In this example, the first image shows a video image in motion. Notice there is no broken or 

distorted lines. 

 

Figure 44: Example of video image with the proper Field Polarity setting
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In the next example, the lines are broken and distorted. In order to adjust the image, change the 

Field Polarity. 

 

Figure 45: Example of video image with the improper Field Polarity setting 

Tips: 

▪ Field Polarity 

Fields are jagged in interlaced image – select Odd Field Up 

▪ Vertical Sync Type 

Flagging at the top of the image – select Block as source 
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▪ Miscellaneous Information 

One frame is one screen of visible data 

A frame of data contains visible AND non-displayed information, image blanking and 
synchronization 

Interlaced signals are comprised of an Odd and Even field of separate Odd and Even lines 

Two fields comprise a frame 

Non-interlaced, also called progressive scan, is one frame of sequential lines 

Fields must be paired properly and “ordered” properly 

After the Auto-SYNC Wizard is Finished for Analog Connections 

Once the user finishes running the IDEA Auto-SYNC Wizard, the Video Setting controls 

are displayed. 

 

Figure 46: IDEA Auto-SYNC screen after completing Auto-SYNC Wizard. 

The window on the right side is the same “Multi-view window” used by the Auto-SYNC Wizard. 

To open a new full-size window: 

▪ click the “Full-size image window” icon from the toolbar or  

▪ click View > Full-size image window (<F10>).  

The Full-size image window will be RGB or Monochrome for DVI-Analog connections or 

NTSC/PAL Video composite for S-Video Composite connections. 
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Once you get to this point, you may now either make changes to your Video settings or exit IDEA 

Auto-SYNC and use a sample Example program. 

Auto-SYNC Video Setting Controls 

Viewing the Info Setting 

The Info options provide information concerning the application that created the current CHP 

file, the AccuStream board type and the serial number. Click Update for IDEA Auto-SYNC to 

verify and/or modify this information. 

 

Figure 47: Info Setting
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Changing the Comments 

When you create a CHP file, you have the option to add your own personal comments to the 

file. The Comments option allows you to add additional comments at any time. 

 

Figure 48: Comments for Video Settings
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Changing Connection Settings 

The options in the Connection tab concern the physical connection of the  

AccuStream board, as well as its channel and sync source. If there are multiple AccuStream 

boards installed in the current system or if you are setting up multiple channels, you should also 

have multiple CHP files.  

 

Figure 49: Connection video settings 

The Connection tab is used to select boards, but is not used to select the video source; those 
selections are grayed out.  
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Changing the Miscellaneous Settings 

Use the Miscellaneous tab to edit the following video settings: 

 

Figure 50: Miscellaneous Settings 

Setting Description 

Vertical Sync 

Type 

Specifies the type of sync information that is  

available during the vertical sync and vertical front porch 

periods. 

External Clock No longer supported. 

Field Polarity Specifies the order of the signal fields. 

Zoom Down Old method of scaling.  No longer supported. 

Pitch Specifies an absolute width reserved for one line of 

video in frame grabber (i.e. video board) memory.) 

Enable Sync 

Filter 

Used only in the accustream170 series frame grabbers.   

Not supported in the AS170+, 205a, HD+ and HD+C 

series frame grabbers. 
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Changing Pixel Adjustments Settings 

The Pixel Adjustments setting tab is used for aligning / adjusting the frame grabbers sync 

circuitry to the incoming video signal. 

 

 

Figure 

51: Pixel 

Adjustment video settings 

  

 

 

Important: When running Auto-SYNC, it is recommended that you use a video image that’s  

representative of the image being captured.  

Option Value Description 

Horizontal Total 1688 pixels Total number of pixels in one video scan-line. 

Horizontal 

Frequency 

63981 Hz Number of scan lines transmitted per second in 

the video signal. 

Phase Delay 9.5 nSec Phase of the sampling clock. 

Fine Adjust 2 Sets fine phase adjustment value for 

AccuStream boards. 

 

HTotal:   Sets the maximum permitted overall 
image width. 
Increasing the HTotal widens the image, 
increasing the aspect ratio.  Decreasing 
the Htotal value shrinks the overall image 
width thus decreasing the aspect ratio. 

Horizontal 

Frequency: 

The number of scan lines transmitted per 
second in the video signal. 
Not usually user adjustable unless 
deliberately sub sampling the incoming 
video.  

Phase 

delay:   

Specifies the phase of the sampling clock, 
which is a delay relative to horizontal 
sync. This allows the sampling operation 
to be optimally placed relative to the 
pixel wave form. 

Use to eliminate shadows or blurriness in 
text or vertical lines in the image. 

Auto..: The "Auto..." button attempts to 
automatically recalculate the optimal 
phase delay setting. If the board supports 
fine phase adjustment, the phase 
algorithm will be ignored and the fine 
phase adjustment value will be set 
instead. 
Auto-SYNC will prompt the user to select 
a phase determination algorithm then 
begin to scan.  
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Auto-SYNC Phase Determination Method uses various algorithms that vary in time to complete 

and thoroughness of testing.  It is recommended that the faster algorithms be used unless the 

results are not satisfactory. This feature is also available from the Auto-SYNC toolbar 

 

Figure 52: Select a Phase Determination Algorithm 

 

 

Figure 53: Phase Determination Status  

You can review the results by looking at the Logarithmic Histogram. The following example 

shows the change that occurs when performed on an analog video. 

 

 

         

Figure 54: Phase Determination Analog Before and After 

 

Before performing a 

phase determination 

After performing a 

phase determination 
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Figure 55: Phase delay adjustment illustration of properly and poorly aligned images 

Frame Tab 

The Frame tab allows adjustment to the image Width, height, centering position of the image. 

Changing Frame Video Settings 

This option allows you to modify options that affect the video frame.  

   

 Figure 56: Frame Video Settings 

To define horizontal AOI:  
Adjust left edge with HBS Increase HBS 
moves image to left; Decrease HBS 
moves image to right. Use to clip left 
side of image.   

Adjust the image right edge with 
WIDTH.  

To define vertical AOI position: 
Adjust top edge - VBP Increase moves 
image up; VBP decrease moves image 
down. Use to clip top of image. 

Adjust the image HEIGHT to set the 
image’s bottom position. 
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Definitions 

Gain/Contrast Setting 

Sets the peak White and Black pixel value. 

▪ Click on the Gain/Contrast tab to view the options. 

  

Figure 57: Gain/Contrast video setting 

 
When an AccuStream RGB is used by a CHP file, Auto-SYNC displays an I-RGB Misc tab that 

allows you to edit the following video settings: 

Option Value Description 

Width 1280 Number of pixels in a line in the image. 

Adjusts the WIDTH (RIGHT) side of the image. 

Height 1024 Number of lines in the image. 

Horizontal 

Back Sync 

348 

pixels 

The time period from the beginning of the 

horizontal sync pulse to the beginning of 

active video. 

Vertical 

Back Porch 

38.0 

lines 

Sets the starting position of the 1st. (TOP) 

scan line of the image. 

Vertical 

Total 

1066 

lines 

Total number of vertical lines in the video 

signal. 

• Adjust Black Level for “Blackness”, 0-5. 

• Adjust Gain level to “Whiteness”, 254-255. This prevents 

clipping peak white or black. 

The following table shows the effect of making changes to each 

of these options. 

Option Value Description 

Black 

Level 

0.0000 

mV 

As Black Level increases, the image 

becomes lighter, but mid-range 

contrast is not affected. 

Gain 0.7140 

mV 

As Gain increases, picture becomes 

darker and has less contrast. 
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Changing AccuStream RGB Settings 

When an AccuStream RGB is used by a CHP file, Auto-SYNC displays an I-RGB Misc tab that 

allows you to edit the following video settings: 

 

 

 

Figure 58: AccuStream RGB video settings 

It is highly recommended that you use the AUTO White Balance! 

The White Balance button starts a process that automatically determines red, green, and blue 

channel gain and offset values for the current video source. AccuStream boards are factory-

calibrated by Foresight Imaging, but you may desire to recalibrate the CHP file based on your 

imaging source. White balancing should be performed when the video source changes. 

Automatic White Balance 

When you click the White Balance button, an information dialog appears. Click Yes to continue. 

An update dialog appears until the process completes. 

I-RGB White Balance settings allow manually adjusting the 

white’s white balance and the blacks by enabling Allow Manual 

Adjustments and adjusting the gain and black level of the RGB 

colors.  

▪ Adjust Gain Red, Green, and Blue levels that White has the 
same pixel value 255-255,255, in the Auto-SYNC pixel reader. 

▪ Adjust OFFSET Adjustment Red, Green, and Blue levels that 
Black has the pixel value 0, 0, 0, in the Auto-SYNC pixel 
reader. 

Option Description 

Gain Sets the RGB gain adjustments for the 

individual red, green, and blue channels. RGB 

gain affects the image contrast. 

Offset 

 

Sets the RGB offset adjustments for the 

individual red, green, and blue channels. RGB 

offset affects the image brightness. 

 



                      IDEA Auto-SYNC with RGB/VGA/DVI Analog Video  

166                                                                                                      TIMS MVP Setup and Configuration Guide 

 

Figure 59: White Balance Information Dialog 

 

Figure 60: White Balance Update Dialog 

When the process completes, confirm whether you want to keep or discard the changes. 

 

Figure 61: Confirm Whether to Keep or Revert the White Balance Changes 

Adjust Combined RGB Settings  

Not Used.  This setting is only for the I-Series and AccuStream170 frame grabbers and not 

applicable to the AccuStream205a, AccuStream+, HD+ and HD+C Series frame grabbers.  
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Saving and Undoing Changes to your Video Settings 

If you make any changes to any of the settings, be sure to select File > Save or 

File > Save As to save these changes. Saving a combined RGB window saves all three of the 

component CHP files to disk. 

 

Figure 62: Saving your CHP file 

If you want to undo any pending changes to your settings, you can restore the video settings by 

selecting File > Reload from Disk. 

Saving an Image 

Once you have an active CHP file, you may save a captured image as a bitmap (BMP) file. This 

BMP may be viewed with any graphics program. To perform this save, select File > Save Image 

As. 

Aspect Ratio Verification Function 

This function verifies the aspect ratio of any captured image, calibrates if needed and adjusts 

the aspect ratio if necessary. 

You can verify the aspect ratio for new or existing Command Hardware Profile (CHP) files. 

Aspect Ratio Menu Selections 

The table provides a description of each of the IDEA Auto-SYNC menu items. 
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Menu Item Description 

 

The first button (on the left) is to hide or show the circle.  

Clicking this toolbar button toggles the circle visibility state 

between shown and hidden. 

 

 
 

The second button (from the left) always centers the circle in 

the image with its edges extending to almost the full 

height/width of the image, leaving a small border.  A 1:1 

aspect ratio between the width – height is always maintained.  

When the size of the image changes, the circle will always 

automatically re-center when you press this button. 

 

 
The third button, showing the circle with red arrows 

extending from it, is for sizing and moving the circle.   

When this button is selected, centering is turned off so you 

can resize the circle.    

• Use your mouse to click the center of the circle (where the 
+ is shown) so that the circle can then be moved.  

• Use your mouse to click on any edge of the circle to drag it 
inward or outward to change the size of the circle. The 
circle resizes from the edge that is dragged, with the 
opposite edge maintaining its currently anchored position. 

 

 

The color selection drop-down menu allows you to change the 

color of the circle. 

 

 

The circle line width lets you change the width in pixels of the 

circle line edges.  The selections are 1, 2, 3, 4, and 1* pixels.   

• The first 4 selections change the width to be 1 pixel, 2 
pixels, 3 pixels, and 4 pixels, respectively.  With any of these 
selections when the image is zoomed, the width increases 
accordingly.   

• The 1* width selection always maintains a 1-pixel width 
regardless of the current zoom state. 
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Procedure for Using the Aspect Ratio Function 

IMPORTANT:  If a calibrated image is not available, then see the Procedure for Non-

Calibrated Images on page 173 first.  

To use aspect ratio function: 

1. Start the IDEA Auto-SYNC program as you normally would using Express mode. 

NOTE: Use the TIMS MVP Setup and Configuration Guide for step-by-step 

instructions for using the IDEA Auto-SYNC program. 

2. When you have completed running Auto-SYNC in Express mode, you will see the Auto-SYNC 
Video Settings Window. 
 

 
 

3. Click the Full Frame icon in the IDEA Auto-SYNC main menu. It is recommended that you 
make the image as large as you can on your monitor. 
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4. Select the hide/unhide circle icon from the IDEA Auto-SYNC main menu to display the white 
circle. 
 

 
 

RESULT: A white circle appears in your captured image. 

 

 
 

5.  In the captured image, target an area which is either a square or circular. In  

     this example we will target a square area. 
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6. Grab the edges of the circle with your mouse, size and position the circle to overlay the target area on 
your image at three points – top, bottom and left. Right-click to zoom image, if needed. 
 

 
 

7. Adjust HTOTAL and reposition the circle horizontally to touch the 
same three points (top, bottom, left). You can also use the Page Up 
or Page Down keys to adjust the HTOTAL. 

NOTE: Do not resize the circle, only reposition. (Hold left mouse 

button on the circle center while using left / right arrow keys).  

• If circle is smaller than the target, increase HTOTAL.  

• If circle is larger than the target, decrease HTOTAL.  
 
 

 

Shortcut keys: There are shortcut keys available to move and resize the circle. See Shortcut 

Keys for details. 

Target the top  

Target the bottom  

Target the left  
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8. Repeat step 7 until the circle matches all four points of the target area. 
 

 

 

9. Once the HTOTAL is set, adjust framing as normal. 
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Procedure for Non-Calibrated Images 

Use these steps when you have a non-calibrated image for which you want to verify the aspect 

ratio. 

1. Follow steps 1 through 4 in the previous procedure. 

2. For a non-calibrated image, x-ray/fluoro a solid round object, preferably metal like a coin.  
 
RESULT: A solid circle will appear in the image as shown. 
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3. Go back to the previous procedure, follow steps 5 through 9 to make adjustments to the 
circle so it overlays correctly on the scanned image over the round object. 
 

 

 

Change the Circle Width or Color 

If you want to change the circle line width from the default of 1 pixel, use the drop-down menu 

to select: 

• a new width (2, 3, o4-pixels) or return to the default (1-pixel 

• the 1* width which maintains a line width of 1-pixel even when you zoom in on the 
image 
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If you want to change the circle color from the default white to another color, use the drop-

down menu to select a new color.  

                             

 

Shortcut Keys 

Use these shortcut keys for: 

• Fine-tuning the location 

• Sizing the circle overlay 

NOTE: You need to use the keyboard and mouse for these shortcuts. 
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Description Shortcuts 

Fine-tuning the 

location 
1. Left-click and hold the left mouse button down in 

the center of the circle to select the circle for 
movement. 

The color changes to indicate the circle 

has been selected. 

2. Use the arrow keys to move the circle 1 pixel in 
the direction of the arrow key selected. 

Sizing the circle 

overlay 

There are four selection points to grab on the 

circle: 

• Top-center 

• Bottom-center 

• Left-center 

• Right-center 

When you hover the mouse over a grab 

point, the cursor changes to a selection 

cursor indicating the circle edge can be 

"grabbed". 

1. Left-click and hold the left mouse button to 
select the grab point on the circle edge.  

This is the edge you will use to either 

increase or decrease the size of the circle. 

The opposite edge of circle will act as an 

anchor point that remains in its location 

while you resize.   

2. Use the arrow keys or the plus (+) and minus (-) 
keys to increase/decrease the circle size at the 
grab point.  

As you increase/decrease the circle size, 

the circle maintains its shape with the 

anchor point remaining in its location as 

you resize. 
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Using Auto-SYNC for Digital Input Connections 

Select the Connection Type 

Auto-SYNC determines the input selection availability based on the model frame grabber being 

used.  Thus an AccuStream+ and AccuStream Express+ 

will not display the Input Connector options as those boards only uses  

DVI-A or DVI-D inputs. 

After verifying the board’s capabilities, IDEA Auto-SYNC will first prompt you to identify the 

AccuStream board mode. Select the connection you have to the AccuStream board and then 

click OK. If you want to keep the selection as your default, click the checkbox below the 

connection selection so that this dialog does not appear again. 

 

 

Figure 63: AccuStream Input Connector 

After you make your selection and click OK, the Hints dialog appears. It is recommended that 

you read the dialog and click OK. If you do not want this dialog to appear each time you start an 

Auto-SYNC session, uncheck the Always display hints before an Auto-SYNC session box. 

Digital input 

connector 
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Figure 64: Hints dialog 

 

         

Figure 65: Calibrating and creating a CHP file 

Example of 

calibration of a 

digital video 

source. 
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Next select the type of input video from the dropdown menu.  

RGB, YPbPr or Monochrome video. 

 

Figure 66: Select RGB, Monochrome or YPbPr video 

Auto-SYNC will measure the incoming video’s pixel clock rate and match the video source with a 

pre-made video format template and create the new chp file. 

 

Figure 67: Prompt to Save CHP file. 
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If the CHP file already exists, you will be prompted to overwrite the file. 

Important: When saving the CHP file, provide a filename that you will easily recognize for your 

video source.  

 

 

Figure 68: Auto-SYNC Video Settings Window  

Note: Digital Images are used in this example. 
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Auto-SYNC for Digital Connections 

With DVI Digital and HDMI sources, not all controls are adjustable or presented since the digital 

interfaces have a reference clock and the data is already in digital form.   

HTotal and Phase are derived from the reference clock and are not adjustable.   

Black Level and Gain (Brightness and Contrast) are adjustable on the SD+, HD+, SD+C and HD+C 

board families where the digital interface allows these modifications. 

Non-Adjustable settings include Htotal, Horizontal Frequency, Phase,  

Vertical Total, Vertical Frequency and White Balance. 

To learn how to adjust the other settings in Auto-SYNC the Auto-SYNC Wizard 

 is available from the Auto-SYNC top menu VIEW or keyboard CTRL-W. 

 

Figure 69: Auto-SYNC Wizard 

Auto-SYNC derives the Image Htotal and image Width and Height values etc 

from the digital video signal then compares these against factory template files 

then presents/writes the best match chp file.   

If you have a video signal that Auto-SYNC miss calibrates to then please contact support@fi-

llc.com for further assistance. 

  

mailto:support@fi-llc.com
mailto:support@fi-llc.com
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Auto-SYNC Wizard Step 1: Creating an Area Of Interest for Digital 

Connections 

To set an Area Of Interest (AOI) we need to adjust the left/right framing of the image. The left 

edge is set by adjusting (HBS) and then the image (WIDTH).  

Increasing the HBS moves the image to the left. 

Then we adjust the VBS to set the top of the image starting position and finally 

reduce HEIGHT to set the bottom position of the image. 

 

If the Auto-SYNC is not viewable then from the Auto-SYNC toolbar select’ VIEW’ 

then  ‘AUTO-SYNC WIZARD’ or press CTRL-W. 

Example 

This first example shows a 1024x768-60Hz Digital video image with the correct values for 

Left/Right Framing. Notice that both edges of the video image align against the edge; there is no 

distortion or clipping.   

 

 

 

 

Figure 70: Example of proper video image framing 
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Let’s set the image AOI to 776x768: 

Set the starting position of the image:  

• Adjust the left edge by increasing HBS to 125. (Horizontal Back Sync) 

• To set the end position of the image: Decrease WIDTH to 776. 

Notice the image width is now the size of the SMPTE circle. 

 

 

 

 

 

Figure 71: Auto-SYNC Wizard Step 1  
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Original image 1024x768, AOI set to 778x690 

 

 

 

 

 

Figure 72: Area of Interest Example  
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AccuStream Auto-SYNC Wizard Step 2: Adjust AOI Top/Bottom 

Framing for Digital Connections 

The next step is to adjust the top/bottom framing of the image.  

To set an image height AOI, you need to adjust the VBP and HEIGHT. 

Increasing the VBP (Vertical Back Porch) moves the image to UP. 

Example 

• To set the top starting position of the image: Increase VBP To 78  

• To set the end position (HEIGHT) of the image: Decrease HEIGHT to 690. 

If Auto-SYNC does not increase VBP beyond a certain value, then you need to decrease HEIGHT 

some more. 

   

Figure 73: Auto-SYNC Wizard Step 2  
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Original image 1024x768, AOI set to 778x690 

 

 

 

 

 

Figure 74: Area of Interest Example  

TIPS: 

When making top/bottom framing adjustments: 

▪ Adjust the top edge with VBP – increase VBP moves image up; decrease VBP moves 

image down. 

o Use to clip the top of image 

o Use to define vertical AOI position 

▪ Adjust bottom edge with height – increase height increases bottom edge; decrease 

height decreases bottom edge. 

o Use to clip edge of image 

o Use to define vertical size of AOI 
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AccuStream Auto-SYNC Wizard Step 3: Adjust Brightness and 

Contrast for Digital Connections 

The next step is to adjust the brightness and contrast of the image. It is normal for the pixels to 

range from 0 to 254. Since the goal is for the image to be visually acceptable, other ranges may 

be desirable. 

 

Figure 75: Auto-SYNC Wizard Step 3  

Brightness and contrast adjustments require a video image that has the full black-to-white 

range. Images with a text pattern are recommended. The histogram is very useful for this step 

so the multi-view window is recommended. 

Position the mouse over the blackest part of the image. Adjust the Brightness value in the 

standard way. Shifting the Brightness changes the pixel values; these changes are visible either 

in the pixel value reader (in the lower right of Auto-SYNC’s status bar) or in the histogram. The 

goal is to have the black pixels correspond to pixel values near 1. 

Once the Brightness is set, move the mouse to the whitest part of the image. Adjust the 

Contrast value until the white pixels correspond to values near 254. 
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Changing the Contrast may affect the results of the Brightness adjustment, so this process must 

be repeated iteratively until the desired brightness and contrast are achieved. Watch the 

histogram to be sure that the range of pixel values extends from 0 to 254 and that not too many 

pixels are being mapped to these extremes (i.e., near-black is mapped to total black). 

Examples 

In this first example, the video image has the correct settings for the brightness and contrast. In 

this image, the mouse is moved to the black part of the image to show the value is correct at the 

0,0,0 setting. For contrast, you would move the cursor over the white part of the image where 

the correct setting would be 255,255,255.  

 

 

 

 

Figure 76: Example of video image with proper settings for brightness and contrast 

Note: If you move the mouse over the black or white areas in the image, the values for 

the black or white portion always display in the lower right hand corner. 

This image has the proper settings for brightness and 

contrast. To determine if your settings are correct, move 

the mouse over the blackest part of the video image. It 

should display as shown below where black is indicated 

by a 0,0,0 setting. 
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In this next example, the black or brightness setting is set too low.  

 

 

 

 

Figure 77: Example of video image where the brightness (Black Level) is too dark 

In order to adjust the setting, do the following: 

1. Click your mouse in the Black field. 

2. Move your mouse over the black area of the image until you find the value 0,0,0 in the 

bottom right hand corner. For example, in the screen example below, move the mouse 

to the black box labeled. 

3. Press the up arrow key once to see if the 0,0,0 value increases. If it does not increase 

above 0,0,0, then the black value is set too low. Keep pressing the up arrow until you 

reach the next value above 0,0,0.  

4. Once you have reached the next value above 0,0,0, then use the down arrow to move 

back to the 0,0,0 value. The Black is now set properly 

  

Move the cursor over the area that you believe is 

set to the correct black value. 
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In this next example, the value for BLACK is set too high. This means when you move the mouse 

cursor over the area which you believe it is set to the correct Brightness value of 0,0,0, it is 

higher than that value. In this example, you can see the value is set to 0,3,9. 

 

                                             

Figure 78: Example of video image where the brightness setting (Black Level) is too high 
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To adjust this value to the correct value for Brightness, do the following: 

1. Click your mouse cursor over the Brightness field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (Black) value on the video image. 

3. Use the down arrow key to move the Brightness (for Black) setting to 0,0,0 which is 

displayed in the bottom right hand corner. Stop pressing the arrow key as soon as you 

reach the 0,0,0 level since if you continue to press the key, the Black Level value will be 

set too low. 

The next example shows how to adjust the Contrast value when it is set too low. In this 

example, the Contrast is based on the white level should be set to 255,255,255.  
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Figure 79: Example of video image where the contrast (White Level) is set too low 

To adjust this value, do the following: 

1. Click your mouse cursor over the Contrast field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (White) value on the video image. 

3. Use the up arrow key to move the Contrast setting to 255,255,255 which is displayed in 

the bottom right hand corner. Stop pressing the arrow key as soon as you reach the 

255,255,255 level since if you continue to press the key, the Contrast value will be set 

too high for contrast. 

  

The mouse cursor must be positioned over the area 

considered to have the correct Contrast value of 

255,255, 255. This is white value. 

Notice below in the left-hand corner the value is set too 

low. 
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In this final example, the Contrast value is set too high. This means that even though it appears 

that the value is set to 255,255,255, it is really set above that value due to the lack of contrast 

with the surrounding white squares. 

 

 

 

 

         

 

Figure 80: Example of video image where the Contrast (White Level) is set too high

The contrast is set too high. This is determined by the fact 

that you cannot see any contrast with the surrounding 

white squares. 

Even though the setting is too high, the display in the lower 

right hand corner displays the maximum Contrast value. 
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To adjust the contrast value that is set too high, do the following: 

1. Click your mouse cursor over the Contrast field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (White) value on the video image 

which in this case is 255,255,255. 

3. Use the down arrow key to move the Contrast setting to the next value below 

255,255,255 which is displayed in the bottom right hand corner. Stop pressing the arrow 

key as soon as you reach the first value below 255,255,255. 

4. Use the up arrow to return to the next value up, which should be 255,255,255. The 

Contrast is now properly set.  

Tips: 

When making Brightness/Contrast adjustments: 

• Have the pixel reader in Full Window mode. 

• Have the Histogram in Quad Window mode. 

• Adjust Brightness for the level of Black. 

• Adjust Contrast for level of White. 

• Ensure Brightness/Contrast is not clipped. 
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AccuStream Auto-SYNC Wizard Step 4: Adjust Miscellaneous 

Settings for Interlaced Digital Video 

The final step of the Auto-SYNC Wizard attempts to correct some basic problems that can occur 

with some interlaced video signals. 

 

Figure 81: Auto-SYNC Wizard Step 6  

A full-size view on an image that has content along the top edge and contains some diagonal 

lines or text is recommended; the SMPTE or linearity patterns are ideal. 

If diagonal lines appear unusually ragged or text in the image appears broken (“shaken”), change 

the Field Polarity value. This adjusts the order in which the fields of the image are assembled 

and reverses the ordering of adjacent scan lines in the video. 

If there appears to be some twisting at the top edge of the image, the Vertical Sync Type may 

need to be adjusted from “Normal” to “Block” or “Extended Block”. 
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The user can run the White Balance procedure to adjust the red, green, and blue channel gain 

and offset compensation values for the particular source to assure that pure white and pure 

black are properly calibrated. White balancing should be performed when the video source 

changes. 

• Click the Finish button to complete the Auto-SYNC Wizard process. You can restart 

the Auto-SYNC Wizard at anytime by selecting a CHP file and clicking the Auto-SYNC 

Wizard toolbar icon or by selecting the View > Auto-SYNC Wizard menu item. 

Example 

In this example, the first image shows a video image in motion. Notice there is no broken or 

distorted lines. 

 

Figure 82: Example of video image with the proper Field Polarity setting
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In the next example, the lines are broken and distorted. In order to adjust the image, change the 

Field Polarity. 

 

Figure 83: Example of video image with the improper Field Polarity setting 

Tips: 

Field Polarity 

Fields are jagged in interlaced image – select Odd Field Up 

Vertical Sync Type 

Flagging at the top of the image – select Block as source 

Miscellaneous Information 

▪ One frame is one screen of visible data 

▪ A frame of data contains visible AND non-displayed information, image blanking 

and synchronization 

▪ Interlaced signals are comprised of an Odd and Even field of separate Odd and Even 

lines 

▪ Two fields comprise a frame 

▪ Non-interlaced, also called progressive scan, is one frame of sequential lines 

▪ Fields must be paired properly and “ordered” properly 
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After the Auto-SYNC Wizard is Finished 

Once the user finishes running the IDEA Auto-SYNC Wizard, the Video Setting 

controls are displayed. 

 

Figure 84: IDEA Auto-SYNC screen after completing Auto-SYNC Wizard. 

The window on the right side is the same “Multi-view window” used by the Auto-SYNC Wizard. 

To open a new full-size window: 

▪ click the “Full-size image window” icon from the toolbar or  

▪ click View > Full-size image window (<F10>).  

The Full-size image window will be RGB or Monochrome for DVI-Analog connections or NTSC/PAL Video 

composite for S-Video Composite connections. 
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Auto-SYNC will open the new CHP files from analog channels CA1 for RGB or for Monochrome 

channels CA1 through CA3. 

Once you get to this point, you may now either make changes to your Video settings or exit IDEA 

Auto-SYNC. You can then use the CHP file with any IDEA Example program located in \Program 

files\Foresight\IDEA\Demo\Bin directory. 

Viewing the Info Setting 

The Info options provide information concerning the application that created the current CHP 

file, the AccuStream board type and the serial number. Click Update for IDEA Auto-SYNC to 

verify and/or modify this information. 

 

 

Figure 85: Info Settings
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Changing the Comments 

When you create a CHP file, you have the option to add your own personal comments to the 

file. The Comments option allows you to add additional information about the video 

source/signal at any time. 

 

 

Figure 86: Comments for Video Settings
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Changing Connection Settings 

The options in the Connection tab concern the physical connection of the AccuStream board, as 

well as its channel and sync source.  

  

 
Figure 87: Connection video 

settings   

Setting Description 

Foresight Board Selects the frame grabber to be 
used. 

Video Channel RGB/YPbPr Analog & Digital 
inputs are grouped as CA1. 
Monochrome channels are 
separate as CA1, CA2, CA3. 

Sync Source CA4 (Composite, Video Sync 
Format, SS, (Separate H&V), SS-
H, (Inverted Hsync)  SS-V, 
(Inverted V Sync), –SS (H&V Sync 
Inserted) 

Pass Mode Single Pass.   Captures the 
images in a single pass. 
Double Pass no longer 
supported. 

RGB Cable Selects the cable types used to 
connect to the frame grabber. 
DVI to BNC 
DVI to VGA 15 pin DSub. 
DVI to DVI (Either analog or 
digital) 
DVI to VGA 5BNC  (Standard DVI 
to 5BNC Analog cable) 
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Connection Settings 

The Connection tab is used to select boards, and video source and cable input type. Video 

Source may not be selectable on certain model frame grabbers.  

Changing the Miscellaneous Settings 

Use the Miscellaneous tab to edit the following video settings: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 
Figure 88: Miscellaneous 

Settings 

Setting Description 

Vertical Sync Type Specifies the type of sync 
information that is available during 
the vertical sync and vertical front 
porch periods. 

External Clock For I-Series and AccuStream170 
frame grabbers only.  Not Used 

Field Polarity Specifies the order of the signal 
fields. 

Zoom Down Old method of scaling for I-Series 
and AccuStream170 frame 
grabbers.  Not Used. 

Pitch Specifies an absolute width 
reserved for one line of video in 
frame grabber (i.e. video board) 
memory. 

Enable Sync Filter Used with the accustream170 
series frame grabbers only. 
Not supported in the 
(AccuStream+, AccuStream HD+ 
and HD+C series frame grabbers) 
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Auto-SYNC Video Settings Tabs 

Changing Pixel Adjustments Settings 

Options available under the Pixel Adjustments tab. 

The following table defines some of the terms available under the Pixel Adjustments tab. 

 

Figure 89: Pixel Adjustment video settings  

 

 
Option 

Default  
Value 

 
Description 

Horizontal 
Total 

1688 pixels Total number of pixels 
in one video scan-line. 

Horizontal 
Frequency 

63981 Hz Number of scan lines 
transmitted per second 
in the video signal.   

Phase Delay 0.0 nSec Not Applicable with 
digital video sources. 

Fine Adjust 0.0 Not Applicable with 
digital video sources. 
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Changing Frame Video Settings 

This option allows you to modify options that affect the video frame. 

 

The following table defines some of the terms available under the Frame tab. 

 

      

Figure 90: Frame Video Settings 

 

 

 

Option Default Value Description 

Width 1280 Number of pixels in a 
line in the image. 

Height 1024 Number of lines in 
the image. 

Horizontal 
Back Sync 

348 pixels The time period from 
the beginning of the 
horizontal sync pulse 
to the beginning of 
active video 

Vertical 
Back Porch 

38.0 
scan lines 

Number of vertical 
blanking lines in the 
video signal that 
does not include any 
vertical sync 
information. 

Vertical 
Total 

1066  
 scan lines 

Total number of 
vertical lines in the 
video signal. 
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Changing Gain/Contrast Setting 

Click on the Gain/Contrast tab to view the options. 

The following table shows the effect of making changes to each of these options. 

 

 

   Figure 91: Gain/Contrast video setting

Option Default Value Description 

Black  
Level 

0.0000 mV As Black Level increases, 
the image becomes 
lighter, but mid-range 
contrast is not affected. 

Gain 0.7140 mV As Gain increases, picture 
becomes darker and has 
less contrast. 
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AccuStream RGB Gain/Offset Settings 

When an AccuStream RGB setting is used by a CHP file, depending on the frame grabber 

model, Auto-SYNC may display an I-RGB Misc tab that normally allows you to edit the 

following video settings:  

 

 

 

Figure 92: AccuStream RGB Gain and Offset video settings 

 

Note:  AccuStream boards are originally calibrated by Foresight Imaging, Inc. 

As White Balance is an analog only function that adjusts the amount of red, green, and blue 

in the black and white portion of the image.  

The White Balance function is not available when using digital video.  

Adjust Combined RGB Settings 

The Combined RGB Settings is only available on the I-Series and 

AccuStream170 frame grabbers and not supported with the  

AccuStream+, HD+ and HD+C series frame grabbers. 

Option Description 

Gain Sets the RGB gain adjustments for the 
individual red, green, and blue channels. 
RGB gain affects the image contrast. 

Offset Sets the RGB offset adjustments for the 
individual red, green, and blue channels. 
RGB offset affects the image brightness. 
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Saving and Undoing Changes to your Video Settings 

If you make any changes to any of the settings, be sure to select  

File > Save or File > Save As to save these changes.  

 

 

Figure 93: Saving your CHP file 

If you want to undo any pending changes to your settings, you can restore the video 

settings by selecting File > Reload from Disk. 

Saving an Image 

Once you have an active CHP file, you may save a captured image as a bitmap (BMP) file. 

This BMP may be viewed with any graphics program. To perform this save, select File > 

Save Image As. 
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Using Auto-SYNC for SDTV Connections  

This chapter describes using Auto-SYNC for SDTV connections with AccuStream HD+ and HD+C 

frame grabbers 

Select the Connection Type 

When you click OK, IDEA Auto-SYNC will first prompt you to identify the AccuStream board 

mode. Select the connection you have to the AccuStream board and then click OK. If you want 

to keep the selection as your default, click the checkbox below the connection selection so that 

this dialog does not appear again. 

 

Figure 94: AccuStream Input Connector 

After you make your selection and click OK, the Hints dialog appears. It is recommended that 

you read the dialog and click OK. If you do not want this dialog to appear each time you start an 

Auto-SYNC session, uncheck the Always display hints before an Auto-SYNC session box. 

 

Note: SDTV is defined as Standard Definition Television formats: 

RS170Yus, NTSC Color/Monochrome 640x480 or  PAL 768x576, S-Video or  

Composite video signal.  

SDTV input connector 



Using Auto-SYNC for Digital Input Connections 

TIMS MVP Setup and Configuration Guide                                                                                               209  

 

Figure 95: Hints dialog 

Next you need to select the type of input video format and channel. 

 

Figure 96: Select NTSC or PAL Video Format and S-Video or Composite 1 video channel 
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Auto-SYNC then measures the incoming video’s pixel clock and compares it against the SDTV 

template chp files then creates the CHP file.  If the CHP file already exists you will be prompted 

to overwrite the file. 

Important: When saving the CHP file, provide a filename that you will easily recognize for your 

video source. 

Next you can add text comments for the CHP file. 

 

Figure 97: Comments on the CHP file 

After you add text comments for the CHP file, the following screen appears. 

 

Figure 98: Start screen for the Auto-SYNC wizard 
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When the Auto-SYNC wizard start page appears, ensure that your PC monitor is properly 

calibrated and you are working in the same illumination as the system you will use. Use the 

calibration dialog to help you determine what changes you need to make, if any. Use the Snap 

(F5) button to refresh the Auto-SYNC window.  

 

Note: Analog Images used in this example. 

     

Figure 99: Calibration Dialog  

 

After selecting the input video being provided, you can start the Auto-SYNC wizard. See Running 

the Auto-SYNC Wizard on page 119. 
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Phase Determination 

Phase Determination is not supported when using SDTV S-video or Composite video inputs with 

the AccuStream HD+ and HD+C series frame grabbers. 

The following phase determination methods are supported: 

Coarse (default): 

Performs a fast measurement survey, generating summary information for about 1/6th of the 

candidate phase values.  

Attempts to locate the candidate with the lowest pixel value standard deviation. 

Runs quickly and provides reasonable results with a wide variety of image/format combinations. 

Refined:  

Performs a thorough measurement survey, generating summary information for all of the 

candidate phase values.  

Typically slower than the other methods, but is more precise and reliable for most image/format 

combinations. 

Thorough: 

Performs a thorough measurement survey, generating detailed image information for all of the 

candidate phase values. 

Uses the image data to precisely measure the image stability at each candidate value and selects 

the most stable. 

This is the slowest method (often slower than manual calibration), but the results are the most 

resilient to changes in temperature and image content. The results are superior to those 

produced by the unaided eye. 

Custom A (StDev best): 

Performs a thorough measurement survey, generating summary information for all candidate 

phase values. 

Is a variation of the Coarse and Refined methods. 

Attempts to locate the candidate with the lowest pixel value standard deviation. 

Custom B (Sharp hunt): 

Performs a fast measurement survey and generates summary information for about 1/6th of the 

candidate phase values.  

Attempts to locate the candidate value with the sharpest histogram peaks. 

This method produces best results with images that are almost entirely an alternating white-

pixel/black-pixel pattern. Examples of such patterns include the checkerboard "resolve" pattern 

and the vertical striped "grill" pattern (with one-pixel stripes). 
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Custom C (Sharp max): 

Similar to Custom B except that it performs a more thorough testing of candidate phase values. 

Running the Auto-SYNC Wizard 

Once the IDEA Auto-SYNC process has completed, the Auto-SYNC Wizard is automatically 

started to facilitate fine tuning of the video settings. The Auto-SYNC Wizard can be started 

manually at any time. 

To start the Auto-SYNC wizard, you can do one of the following: 

▪ Click the Skip Intro to skip the video calibration images information. The three page introduction 

provides basic information about image calibration and introduces the standard image 

types that are most useful when using the Auto-SYNC Wizard. To view details on the video 

calibration images, see Recommended Calibration Images on page 106. 

▪ To view the video calibration images information as part of the Auto-SYNC wizard, click 

Next. 

 

 

Figure 100: IDEA Auto-SYNC Wizard introductory screen once the CHP file is created 

The upper window on the right side is called the “Multi-view window”. The Multi-view window 

displays multiple monochrome views of the image (zoom, histogram, etc.) and also displays the 

board type (and its serial number) that is being used. When using an AccuStream board, the 

Multi-view window can display either Y-only (luma) grayscale or one of the three RGB color 

planes. The figure also shows a full-size window that displays the entire image (with scroll bars, 

if needed). Both windows are useful when running the Auto-SYNC Wizard. 
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Every page of the Auto-SYNC Wizard includes a pair of Back/Next buttons for navigation; steps 

in the Auto-SYNC Wizard can be repeated as needed. Convenient buttons to bring up the 

Histogram (in the multi-view window) or the Full-Size view window on the CHP file are available. 

After viewing the Auto-SYNC Wizard introduction, the tuning process begins. There is a large 

button on the first introduction page that skips to the first tuning step. On the last introduction 

page is a checkbox that hides the introduction pages the next time the Wizard is used; the user 

can also enable/disable the introduction from Auto-SYNC’s Preferences menu. 

The Auto-SYNC Wizard process varies slightly for different board types. 
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AccuStream Auto-SYNC Wizard Step 1: Adjust HTotal for SDTV 

Connections 

In the Analog world normally the video’s Horizontal Total (HTotal) can be 

adjusted, however, due to the design of the AccuStream Express HD+ frame grabber when using 

the S-Video or BNC inputs AutoSYNC will use factory pre-made SDTV CHP files and HTotal is not 

adjustable. 

 

If the SDTV video is connected using the DVI to 5 BNC cable (P/N: 030093), the DVI to BNC 

Adapter (P/N: 030175) or the S-Video to BNC cable (P/N: 030193),  

then AutoSYNC will measure the incoming video source and Htotal is 

adjustable. 

 

Use of the DVI to 5 BNC cable or DVI to BNC adapter for NTSC Color S-Video or Composite video 

signals requires a low pass filter or a color burst filter to filter  

out the color information, or else the color information will produce a herringbone pattern in 

the video. Use of this procedure will result in MONOCHROME video. 

 

Adjusting Htotal for SDTV using the DVI Adapters 

Htotal is the number of pixels per scan line in the video signal; some of these pixels are not part 

of the active video (e.g., porches which are on the right and left side of the image) so HTotal 

represents the active plus the inactive video signal measured as pixels. Increasing the HTotal 

widens the image, increasing the aspect ratio.  

Note: Be aware of the monitor format (your display, (for example, is it 5:4 or  

         16:9), before adjusting the HTotal. Your display monitor aspect ratio  

          should be set to the same aspect ratio as the video source. 
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Figure 101: Auto-SYNC Wizard Step 1  

HTotal adjustments require a video image that highlights errors in aspect ratio. An image with 

circles or squares or a text pattern is recommended. 

Note: Htotal’s value must be divisible by 4. 

If your video is interlaced, look at the image to see if text or diagonal/curved lines appear 

ragged. If the text or lines do, try adjusting the Field Polarity to change the ordering of 

fields/frames. Depending on the video pattern, changes to the field ordering may have 

invalidated the results of the Auto-SYNC session. You may want to rerun Auto-SYNC to generate 

a new CHP file. 

The HTotal is adjusted by typing a new value into the edit box or using the up/down buttons; the 

arrow and Page Up/Down keys also work. Changes to the HTotal are reflected in any open views 

of the CHP file (multi-view, full-size view). Focus on getting the aspect ratio correct; the image 

framing will be adjusted in a later step. 
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Aspect Ratio (HTotal) Adjustment Example 

This first example shows a video image with the correct values for aspect ratio. Notice that the 

circle and square shapes are not distorted. Another good way to check aspect ratio is with text 

images. 

 

 

 

 

Figure 102: Example of Aspect Ratio (HTotal) with Correct Values 

Verify that the shapes (or text) in the 

video image are not distorted. This 

ensures that the video image has the 

correct aspect ratio. 
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This next example shows a video image that is too narrow. You will notice in this example that 

the square and circle shapes are distorted vertically. The square and circle images are too 

narrow. 

 

 

 

 

 

Figure 103: Example of Aspect Ratio (HTotal) that needs a horizontal adjustment 

To correct the above example, change the HTOTAL value to a higher value by entering a higher 

number in the text box or using the up arrow key to change the value. Keep changing the value 

until the shapes appear correct. 

 

  

 

Notice the circle is oblong because it is 

too narrow, as well as, the squares have 

a rectangle shape. 
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The next example shows a video image that is too wide. The shapes will have the same 

distortions as shown in the previous example, but horizontally. 

 

 

 

 

 

Figure 104: Example of Aspect Ratio (HTotal) that needs a vertical adjustment 

To correct the above example, change the HTOTAL value to a lower number by entering a lower 

number in the field or using the down arrow key to change the value. Keep changing the value 

until the shapes appear correct. 

 

  

 

Notice the circle is oblong because it is 

too wide, as well as, the squares have a 

rectangle shape. 
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In this last example, you will see the aspect ratio distorted when viewing a video image with 

text. 

 

 

 

 

Figure 105: Example of Aspect Ratio with text that needs adjustment 

When text is distorted, it is recommended that you change the Field Polarity.  

TIPS: 

Use the Histogram to view changes needed, if any. Use this Auto-SYNC step to make sure of the 

following: 

▪ Make changes to HTOTAL if you have issues with any of the following: 

• Circles are not concentric 

• Squares are not “square” 

• Text is not even and consistent across 

▪ Make aspect ratio adjustments through HTotal: 

• Increase HTotal to widen image 

• Decrease HTotal to narrow image 

Notice the distortion in this area of the 

text. The white letters are broken and 

skewed. 
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AccuStream Auto-SYNC Wizard Step 2: Adjust Left/Right Framing 

for SDTV Connections 

The next step is to adjust the left/right framing of the image. The left edge is set first and then 

the image width. The left edge is set by the value of the Horizontal Back Sync (HBS), which 

represents the period between a horizontal sync pulse and the start of active video. The image 

width is set as the number of pixels per line. 

 

Figure 106: Auto-SYNC Wizard Step 3  

Framing adjustments require an image that has a non-black background that extends across the 

entire image. The SMPTE pattern is recommended. 

The Horizontal Back Sync (HBS) is adjusted in the standard way. Increasing the HBS moves the 

image to the left. Set the HBS so that the image’s background extends fully to the left of the 

viewing window. 
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Once the HBS is set, the image width can be adjusted in the standard way until the full width of 

the image appears in the viewing window. Now that the full image width is visible, it is possible 

that the aspect ratio was incorrectly set in Step 1; click the <<Back button to go to Step 1 to fix 

it. 

Note:  When adjusting HBS, the number of pixels per line is adjusted so that the image extends 

to the left of the viewing window. 

Example 

This first example shows a video image with the correct values for Left/Right Framing. Notice 

that both edges of the video image align against the edge; there is no distortion or clipping. 

 

 

Figure 107: Example of proper video image framing 
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In the next example, the video image is too large and is clipped on its left edge. 

 

 

 

 

 

Figure 108: Example of framing values too large 

To adjust the image, decrease the HBS value to move the image to the right. This 

adjustment will result in the whole image displaying without a clipped left edge.  

 

Notice that the left edge is 

clipped. This is because the 

image is too large. 
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In the next example, the video image is too small. The image is too far from the left edge. 

 

 

 

Figure 109: Example of framing values too small 

To adjust the image, increase the HBS value to move the image to the left edge.  

The image is too small and is too 

far from the left edge. 
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In the next example, the image width is too small and needs to increase the width to the right 

edge. 

 

 

 

 

 

 

Figure 110: Example of video image that is not wide enough 

 

To adjust the video image, increase the image width to widen the image to the right edge. 

The image is clipped 

on the right side. The 

image needs to be 

widened to the 

right edge. 
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In the next example, the image width is too wide.  

 

 

 

 

 

 

Figure 111: Example of video image that is too wide  

 

To adjust the video image, decrease the image width to fit into the left and right edges. 

 

When the image is too large, 

the left edge is clipped and the 

right edge has a blank area. 
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TIPS: 

When making left/right framing adjustments: 

▪ Adjust the left edge with HBS – increase HBS moves image to left; decrease HBS moves 

image to right. 

• Use to clip the image’s left side. 

• Use to define horizontal Area of Interest (AOI) position. 

▪ Adjust the right edge with image width – increase width increases right edge; decrease 

width decreases the left edge. 

• Use to clip right side of image. 

• Use to define horizontal size of AOI. 
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AccuStream Auto-SYNC Wizard Step 3: Adjust Top/Bottom 

Framing for SDTV Connections 

The next step is to adjust the top/bottom framing of the image. The top edge is set first and 

then the image height. The top edge is set by the value of the Vertical Back Porch (VBP), which 

represents the number of vertical blanking lines in the video signal from the trailing edge of the 

vertical sync to the start of active video. The image height is set as the number of lines in the 

image. 

 

Figure 112: Auto-SYNC Wizard Step 4  

Framing adjustments require an image that has a non-black background that extends image 

upward. Set the VBP so that the image’s background extends fully to the top of the viewing 

window. 

Once the VBP is set, the image width can be adjusted in the standard way until the full height of 

the image appears in the viewing window. 
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Examples 

In this example, the video image is too large and extends beyond the top edge. 

 

 

 

 

Figure 113: Example of video image that is clipped at the top edge 

 

To adjust the image, decrease the VBP to move the image down. This will align the video image 

to the top edge. 

The image is clipped at the top 

edge. The bottom edge is properly 

aligned. 
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In the next example, the video image is too small. The top edge is clipped and the bottom edge 

is above the bottom edge of the image. 

 

 

 

 

 

 

 

Figure 114: Example of video image that is clipped at the top edge and is not aligned with the bottom edge 

To adjust the image, increase the VBP to increase the size of the image. This will align the video 

image to the top edge. 

The top edge of the image is clipped 

and the bottom edge is not aligned. 
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In the next example, the video image is too small and is not reaching the bottom edge. 

 

 

 

 

Figure 115: Example of image that is too far from the bottom edge 

To adjust the image, increase the height to increase the bottom edge. This will align the video 

image to bottom edge. 

The image is not aligned to the 

bottom edge. 
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In the next example, the video image is too large and is distorted at the bottom edge. 

 

 

 

 

 

Figure 116: Example of video image that is not aligned to the bottom edge 

To adjust the image, decrease the height to decrease the bottom edge. This will align the video 

image to bottom edge. 

 

TIPS: 

When making top/bottom framing adjustments: 

▪ Adjust the top edge with VBP – increase VBP moves image up; decrease VBP moves image 

down. 

• Use to clip the top of image 

• Use to define vertical AOI position 

▪ Adjust bottom edge with height – increase height increases bottom edge; decrease height 

decreases bottom edge. 

• Use to clip edge of image 

• Use to define vertical size of AOI 

The image is too large and does not align 

to the bottom edge. 
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AccuStream Auto-SYNC Wizard Step 4: Adjust Brightness and 

Contrast for SDTV Connections 

The next step is to adjust the brightness and contrast of the image. It is normal for the pixels to 

range from 0 to 255. Since the goal is for the image to be visually acceptable, other ranges may 

be desirable. 

 

Figure 117: Auto-SYNC Wizard Step 5  

Brightness and contrast adjustments require a video image that has the full black-to-white 

range. Images with a text pattern are recommended. The histogram is very useful for this step 

so the multi-view window is recommended. 
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Position the mouse over the blackest part of the image. Adjust the Brightness value in the 

standard way. Shifting the Brightness changes the pixel values; these changes are visible either 

in the pixel value reader (in the lower right of Auto-SYNC’s status bar) or in the histogram. The 

goal is to have the black pixels correspond to pixel values near 1. 

Once the Brightness is set, move the mouse to the whitest part of the image. Adjust the 

Contrast value until the white pixels correspond to values near 255. 

Changing the Contrast may affect the results of the Brightness adjustment, so this process must 

be repeated iteratively until the desired brightness and contrast are achieved. Watch the 

histogram to be sure that the range of pixel values extends from 0 to 255 and that not too many 

pixels are being mapped to these extremes (i.e., near-black is mapped to total black). 

Examples 

In this first example, the video image has the correct settings for the brightness and contrast. In 

this image, the mouse is moved to the black part image to show the value is correct at the 0,0,0 

setting. For contrast, you would move the cursor over the white part of the image where the 

correct setting would be 255,255,255.  
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Figure 118: Example of video image with proper settings for brightness and contrast 

Note: If you move the mouse over the black or white areas in the image, the values for the 

black or white portion always display in the lower right-hand corner. 

This image has the proper settings for brightness and contrast. To 

determine if your settings are correct, move the mouse over the 

blackest part of the video image. It should display as shown below 

where black is indicated by a 0,0,0 setting. 
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In this next example, the black or brightness setting is set too low.  

 

 

 

 

Figure 119: Example of video image where the brightness (Black Level) is too dark 

In order to adjust the setting, do the following: 

1. Click your mouse in the Brightness field. 

2. Move your mouse over the black area of the image until you find the value 0,0,0 in the 

bottom right hand corner. For example, in the screen example below, move the mouse 

to the black box labeled. 

3. Press the up arrow key once to see if the 0,0,0 value increases. If it does not increase 

above 0,0,0, then the black value is set too low. Keep pressing the up arrow until you 

reach the next value above 0,0,0.  

4. Once you have reached the next value above 0,0,0, then use the down arrow to move 

back to the 0,0,0 value. The Brightness is now set properly 

In this next example, the value for Brightness is set too high. This means when you move the 

mouse cursor over the area which you believe it is set to the correct Brightness value of 0,0,0, it 

is higher than that value. In this example, you can see the value is set to 0,3,9. 

 

Move the cursor over the area that you believe is 

set to the correct black value. 
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Figure 120: Example of video image where the brightness setting (Black Level) is too high 
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To adjust this value to the correct value for Brightness, do the following: 

1. Click your mouse cursor over the Brightness field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (Black) value on the video image. 

3. Use the down arrow key to move the Brightness (for Black) setting to 0,0,0 which is 

displayed in the bottom right hand corner. Stop pressing the arrow key as soon as you 

reach the 0,0,0 level since if you continue to press the key, the Black Level value will be 

set too low. 

The next example shows how to adjust the Contrast value when it is set too low. In this 

example, the Contrast is based on the white level should be set to 255,255,255.  
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Figure 121: Example of video image where the contrast (White Level) is set too low 

To adjust this value, do the following: 

1. Click your mouse cursor over the Contrast field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (White) value on the video image. 

3. Use the up arrow key to move the Contrast setting to 255,255,255 which is displayed in 

the bottom right hand corner. Stop pressing the arrow key as soon as you reach the 

255,255,255 level since if you continue to press the key, the Contrast value will be set 

too high for contrast. 

  

The mouse cursor must be positioned over the area 

considered to have the correct Contrast value of 255,255, 

255. This is white value. 

Notice below in the left hand corner the value is set too 

low. 
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In this final example, the Contrast value is set too high. This means that even though it appears 

that the value is set to 255,255,255, it is really set above that value due to the lack of contrast 

with the surrounding white squares. 

 

 

 
                   

Figure 122: Example of video image where the Contrast (White Level) is set too high

The contrast is set too high. This is determined by the fact 

that you cannot see any contrast with the surrounding 

white squares. 

Even though the setting is too high, the display in the lower 

right hand corner displays the maximum Contrast value. 
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To adjust the contrast value that is set too high, do the following: 

1. Click your mouse cursor over the Contrast field on the left hand side. 

2. Move your mouse cursor over the lowest Contrast (White) value on the video image 

which in this case is 255,255,255. 

3. Use the down arrow key to move the Contrast setting to the next value below 

255,255,255 which is displayed in the bottom right hand corner. Stop pressing the arrow 

key as soon as you reach the first value below 255,255,255. 

4. Use the up arrow to return to the next value up, which should be 255,255,255. The 

Contrast is now properly set.  

 

Tips: 

When making Brightness/Contrast adjustments: 

• Have the pixel reader in Full Window mode. 

• Have the Histogram in Quad Window mode. 

• Adjust Brightness for the level of Black. 

• Adjust Contrast for level of White. 

• Ensure Brightness/Contrast is not clipped. 
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AccuStream Auto-SYNC Wizard Step 5 for SDTV Connections 

Click Next. If you need to adjust filters, go to the SDTV Format tab and click the Advanced 

button. 

 

 

Figure 123: Auto-SYNC Wizard Step 5  
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AccuStream Auto-SYNC Wizard Step 6: Adjust Miscellaneous 

Settings for SDTV Connections 

The final step of the Auto-SYNC Wizard attempts to correct some basic problems that can occur 

with some video signals. 

 

Figure 124: Auto-SYNC Wizard Step 6  

A full-size view on an image that has content along the top edge and contains some diagonal 

lines or text is recommended; the SMPTE or linearity patterns are ideal. 
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If diagonal lines appear unusually ragged or text in the image appears broken (“shaken”), change 

the Field Polarity value. This adjusts the order in which the fields of the image are assembled 

and reverses the ordering of adjacent scan lines in the video. 

If there appears to be some twisting at the top edge of the image, the Vertical Sync Type may 

need to be adjusted from “Normal” to “Block” or “Extended Block”. 

The user can run the White Balance procedure to adjust the red, green, and blue channel gain 

and offset compensation values for the particular source to assure that pure white and pure 

black are properly calibrated. White balancing should be performed when the video source 

changes. 

Click the Finish button to complete the Auto-SYNC Wizard process. You can restart the 

Auto-SYNC Wizard at anytime by selecting a CHP file and clicking the Auto-SYNC Wizard toolbar 

icon or by selecting the View > Auto-SYNC Wizard menu item. 
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Example 

In this example, the first image shows a video image in motion. Notice there is no broken or 

distorted lines. 

 

Figure 125: Example of video image with the proper Field Polarity setting
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In the next example, the lines are broken and distorted. In order to adjust the image, change the 

Field Polarity. 

 

Figure 126: Example of video image with the improper Field Polarity setting 

Tips: 

Field Polarity 

Fields are jagged in interlaced image – select Odd Field Up 

Vertical Sync Type 

Flagging at the top of the image – select Block as source 

Miscellaneous Information 

▪ One frame is one screen of visible data 

▪ A frame of data contains visible AND non-displayed information, image blanking and 

synchronization 

▪ Interlaced signals are comprised of an Odd and Even field of separate Odd and Even 

lines 

▪ Two fields comprise a frame 

▪ Non-interlaced, also called progressive scan, is one frame of sequential lines 

▪ Fields must be paired properly and “ordered” properly 
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After the Auto-SYNC Wizard is Finished 

Once you finish running the IDEA Auto-SYNC Wizard, the Video Setting controls are displayed. 

 

Figure 127: IDEA Auto-SYNC screen after completing Auto-SYNC Wizard. 

The window on the right side is the same “Multi-view window” used by the Auto-SYNC Wizard. 

To open a new full-size window: 

▪ click the “Full-size image window” icon from the toolbar or  

▪ click View > Full-size image window (<F10>).  

The Full-size image window will be RGB or Monochrome for DVI-Analog connections or NTSC/PAL Video 

composite for S-Video Composite connections. 

Once you get to this point, you may now either make changes to your Video settings or exit IDEA 

Auto-SYNC and use a sample Example program. 
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Viewing the Info Setting 

The Info options provide information concerning the application that created the current CHP 

file, the AccuStream board type and the serial number. Click Update for IDEA Auto-SYNC to 

verify and/or modify this information. 

 

Figure 128: Info Settings
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Changing the Comments 

When you create a CHP file, you have the option to add your own personal comments to the 

file. The Comments option allows you to add additional comments at any time. 

 

Figure 129: Comments for Video Settings
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Changing Connection Settings 

The options in the Connection tab concern the physical connection of the AccuStream board, as 

well as its channel and sync source. If there are multiple AccuStream boards installed in the 

current system or if you are setting up multiple channels, you should also have multiple CHP 

files.  

        

Figure 130: Connection video settings 

The Connection tab is used to select boards, but is not used to select the video source; those 

selections are grayed out.  
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Changing the SDTV Format 

Use the SDTV Format tab to select a video source and output format.   

• The Video Source selections include NTSC, PAL, S-Video or Composite input. 

• The Output Format selects the format for the selected video source.  

• The Advanced button allows you to adjust these video settings.  

 

IMPORTANT: If you want to use the Advanced button to adjust video settings, it is 

recommended that you contact Foresight Imaging using any of the methods listed on the back 

cover of this manual. 

 

 

Figure 131: SDTV Format Settings
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Changing the SDTV Miscellaneous Settings 

Use the Miscellaneous tab to edit the following video setting: 

 

Figure 132: Miscellaneous Settings 

 

 

Setting Description 

Field 

Polarity 

Specifies the order of the signal fields. 
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Changing SDTV Settings 

Use the SDTV Settings tab to edit the following video settings: 

 

         

Figure 133: SDTV Settings  

 

It is easiest to adjust these video settings when continuous capture is active. Updating the 

values in single snap mode can be slow. 

Setting Description 

Brightness The brightness adjustment 
determines the black level of the 
video processing. 

Contrast The contrast adjustment 
determines the luminance 
(proportional to intensity) 
produced for white. 

Hue Changes the phase offset of the 
chroma demodulator thus 
changing the tint of the image. 

Saturation Sets the amount of color in the 
image.  
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Changing Pixel Adjustments Settings 

The Pixel Adjustments settings are not adjustable in SDTV mode. 

       

Figure 134: Pixel Adjustment video settings 

 

 

Option Default 

Value 

Description 

Horizontal 
Total 

780 pixel Total number of pixels 
in one video scan-line. 

Horizontal 
Frequency 

15734 Hz Number of scan lines 
transmitted per second 
in the video signal. 

Phase 
Delay 

3.0 nSec Phase of the sampling 
clock. 

Fine Adjust 0.0 Sets fine phase 
adjustment value for 
AccuStream boards. 
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Changing Frame Video Settings 

This option allows you to modify options that affect the video frame. 

 

Figure 135: Frame Video Settings 

 

The table defines some of the terms available under the Frame tab.

  

Option Default  

Value 

Description 

Width 640  Number of pixels in a 
line in the image. 

Height 480 Number of lines in the 
image. 

Horizontal 
Position 

54 pixels Accounts and adjusts 
for board delays (due to 
electronics. 

Vertical Back 
Porch 

13.5 scan 
lines 

Number of vertical 
blanking lines in the 
video signal that does 
not include any vertical 
sync information. 

Vertical Total 0 scan lines Total number of vertical 
lines in the video signal. 
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Saving and Undoing Changes to your Video Settings 

If you make any changes to any of the settings, be sure to select File > Save or File > Save As to 

save these changes. Saving a combined RGB window saves all three of the component CHP files 

to disk. 

 

Figure 136: Saving your CHP file 

If you want to undo any pending changes to your settings, you can restore the video settings by 

selecting File > Reload from Disk. 

Saving an Image 

Once you have an active CHP file, you may save a captured image as a bitmap (BMP) file. This 

BMP may be viewed with any graphics program. To perform the save, select File > Save Image 

As. 
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TIMS MVP System Maintenance 

Scope 

This guide describes recommended preventive maintenance to ensure TIMS MVP systems and 

TIMS Review stations run as smoothly as possible.   

Since TIMS MVP and TIMS Review computers are Windows 10-based computers, preventive 

maintenance is typical of any Windows 10 operating system.   

Maintenance consists of: 

• checking and optimizing the hard drive 

• verifying disk space 

• deleting older TIMS MVP studies, and  

• cleaning system airflow grills. 

Notes 

About the TIMS Review Software 

TIMS Review software is loaded on site supplied computers. Third party utility programs may be 

installed, and menus depicted will differ. Please consult your IT group and the specific program 

documentation. 
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Maintenance Requirements 

What You Need 

You will need a canister of compressed air, a label, and familiarity with Windows 10 system 

administration. 

Time Required 

Maintenance can take from 30 minutes to several hours depending on the amount of disk 

fragmentation and amount of space used on the hard drive.  

Maintenance Frequency 

Maintenance is recommended once every three months. 

Why Study Storage Maintenance is Required 

TIMS MVP and TIMS Review application performance will degrade when the system hard drive is 

nearing capacity. 

In addition, TIMS MVP and TIMS Review stations are designed for temporary, short-term study 

storage ONLY. Long term study storage is performed on PACS.  

PACS systems contain standard disk backup and redundancy mechanisms for long term data 

storage. 

Recommendation 

To preserve TIMS MVP and TIMS Review disk space, it is recommended that you delete any 

TIMS MVP studies over six (6) months old. 

How Delete Studies in TIMS MVP 

To delete studies: 

1. First, verify that all TIMS MVP studies to be deleted are on PACS and are backed up. 

2. In TIMS MVP or TIMS Review, click the OPEN icon to open the study list. When the study 
list opens, note the current study list sort selection.  
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3. Click on the Study Date column. If it is not in descending order, where the oldest studies 
are listed on the bottom, then click again. 
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4. After verifying all the studies are on PACS:  

a. click on the oldest study located at the bottom of the list. 

b. Hold down the ß key and then use the Up Arrow ˜ key to highlight older 
studies. 

c. Right-click on the list and select Delete. 

 

5. Click Cancel to stop the study deletions or click OK to delete the selected studies. 
  
IMPORTANT: This is a destructive delete. This means you will not be able to recover the 
studies in TIMS MVP or TIMS Review. However, you will be able to access studies that have 
been backed up in PACS or some other system. 

  
 

6. Return the Study Date column sort to the original setting. 
 

7. Reboot and restart the TIMS MVP or TIMS Review system. 
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Optimize (Defragment) the Hard Drive 

To check and optimize or defragment the hard drive: 

1. Click the Windows Search bar in the bottom left-hand corner of the screen and type 
optimize. 
 
Click the Defragment and Optimize Drives selection.  
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2. Click to highlight the C: drive.  Click the Optimize button. 
 

 

 

Result: Depending on the amount of fragmentation, it may take from 15 minutes to several 

hours to complete. 
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Verify Disk Space 

To verify the disk space: 

1. Click the Windows Search bar in the bottom left-hand corner of the screen and type select 
This PC. 
 

 
 

2. Select the (C:) drive and note the amount of free disk space.  
 
It is recommended that if there is less than 30% free disk space, then you need to consider 
deleting files to keep the system running optimally. 
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Run a Check Disk on the Hard Drive 

To run a check disk on the hard drive: 

1. Click the Windows Search bar in the bottom left-hand corner of the screen and type select 
This PC. 
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2. Right-click on the C: Drive and select Properties from the menu. 
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3. Click the Tools tab and under Error-checking click the Check button. 
 

 
 

4. Select Scan drive. 
 

 
 

5. When the scan is completed, click Close. 

6. Reboot the TIMS MVP or TIMS Review system. 
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Verify TIMS MVP Disk Study Space Limit 

To verify the TIMS MVP disk study space limit: 

1. In TIMS MVP or TIMS Review, click Help and select Configuration. 
 

 

2. Type in the administrator password and click OK. 
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3. On the TIMS MVP Config page, enable OLD STUDY PURGE and set it to 15%. Click OK. 
 

 

Clean TIMS Computer Air Grills 

To clean the TIMS computer air grills: 

IMPORTANT: Perform this step in three (3) intervals. 

1. Ensure that the grill of the TIMS computer system is not blocked.  

2. Shut down the TIMS computer system and then direct the compressed air (from the 
canister) towards the grill to remove dust particles. 

NOTE: TIMS computer shown.  For TIMS Review computer, clean as per manufacturer’s 

recommendations. 

   

 

3. Upon completion of Preventive Maintenance, affix a label to the TIMS computer indicating 
date of preventative maintenance. 
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Revision History  

Revision: Date: Comments: 

1 09/01/20 Release 

   

   

 

For additional information & assistance, contact: Support@tims.com, +978-458-4624 x204 

 

  

mailto:Support@tims.com
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TIMS MVP / Review Maintenance Checklist Log 

TIMS MVP / REVIEW Maintenance Checklist / Log 

SITE:         

ADDRESS:         

       

       

       

TIMS MVP S/N:         

TIMS MVP Rev:        

 

Checklist: Comments: 

 Delete old TIMS MVP Studies       

 Defragment hard drive       

 Verify hard drive space         

 Perform Check Disk       

 Verify / Set TIMS MVP drive space limit       

 Clean Air Grills       

       

       

Performed Service:       

 Name:              

 Date:                

       

Performed Service:       

 Name:              

 Date:                

       

Performed Service:       

 Name:              

 Date:                

       

Performed Service:       

 Name:              

 Date:                
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Appendix A: 

Hazardous Substance Statement 
The following table lists toxic or hazardous elements by product: 

O: Indicates that this toxic or hazardous substance is contained in all of the homogeneous 

materials for this part is below the limit requirement. 

X: Indicates that this toxic or hazardous substance is contained in at least one of the 

homogenous materials for this part is above the limit requirement. 

 

  

  

TOXIC OR HAZARDOUS SUBSTANCES AND ELEMENTS 

 PRODUCT    HEXAVALENT POLYBROMINATED POLYBROMINATED 

 LEAD MERCURY CADMIUM CHROMIUM BIPHENYLS DIPHENYL ETHERS 

 (Pb) (Hg) (Cd) (Cr(VI)) (PBB) (PBDE) 

AccuStream 
Express 
HD+ O O O O O O 
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Appendix B: Modalities Without an Auxiliary Video 

Output 
When an imaging device does not have auxiliary video, two options are available for the TIMS 

connection. 

Using a Video Splitter 

Foresight Imaging’s Active Video Splitter can be connected to the Video Out of the device with 

one cable going to TIMS and the other to the monitor of the device. 

 

 

TIMS 

Video 

Splitter 

Modality – no 

auxiliary 

Modality 

Monitor 

Video 

Out 

Video 

Out 1 

Video 

Out 2 
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Channel, Deleting, 35, 36 

Channels, 27 

CHP Files, 108 

location, 108 

Configuration File, 93 

export, 93 

importing, 94 

Configure the TIMS Worklist, 42 

Configuring Channels, 27 

Configuring DICOM Destinations, 54 

Configuring Security, 87 

Connection Settings, 159, 201, 250 

Creating CHP File, 112 

Custom Hardware Profile 

creating, 102 

DICOM Server 

add, 58 

configure settings, 54 

delete, 65, 72 

duplicate settings, 66, 72 

edit, 63, 70 

local settings, 57 

Digital input connections 

Adjust AOI Top/Bottom Framing for Digital Connections. 
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Adjust Brightness and Contrast for Digital Connections, 

187 

Adjust Miscellaneous Settings for Interlaced Digital Video, 

195 

Creating an Area Of Interest for Digital Connections, 182 

Select the Connection Type, 177 

Disk Space 

verify, 263 

Duplicate a Channel, 36 

Frame Video Settings, 163, 204, 255 

Front View, 5 

Gain/Contrast Setting, 164, 205 

Hard Drive 

optimize, 261 

run a check disk, 264 

IDEA Auto-SYNC 

starting, 106 

IDEA Auto-SYNC with RGB/VGA/DVI Analog Video, 113 

Label 

add a series description name, 75 

delete, 79 

duplicate, 81 

edit, 78 

Labels 

for series description tags, 74 

Maintenance 

checklist log, 270 

frequency, 258 

requirements, 258 

Modality Connections, 7 

Monochrome Connections, 11, 12 

Network Setup, 15 

Non-NTSC/PAL, 8 

NTSC/PAL, 8 

Open to Worklist, 43 

PC Connections, 5 

Rear View (Backplane), 5 

RGB Connections, 11, 12 

RGB/VGA/DVI analog video 

Adjust Brightness and Contrast for Analog Connections, 

144 

Adjust HTotal for Analog Connections, 122 

Adjust Left/Right Framing for Analog Connections, 132 

Adjust Miscellaneous Settings for Analog Connections, 

153 

Adjust Phase Delay for Analog Connections, 128 

Adjust Top/Bottom Framing for Analog Connections, 139 

Select the Connection Type, 113 

Security, 87 

Site Survey, 1 
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changing the directory, 92 

delete, 258 

purging, 91 

verify TIMS disk space, 267 

Study Dashboard 

select fields, 89 

Study List 

configure, 89 

S-Video, 12 

S-Video (Y/C) Connections, 12 

TIMS Checklist, 2 

TIMS MVP Review Software, 257 

TIMS System Maintenance, 257 

Triggers, 13 

Typical System Unit, 4 

Typical TIMS Installation, 2 

Typical TIMS System Installation 

installation checklist, 2 

Using a Video Splitter, 272 

Using Auto-SYNC for Digital Input Connections, 177 

Using IDEA Auto-SYNC, 102 

Verifying Audio, 18 

Video Splitter, 272 

Video Splitter Isolator, 14 

Windows Active Directory, 82 

Worklist 

add, 48 

delete, 50 

duplicate, 52 

edit, 51 

retain UID, 95 

Worklist Local Settings 
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Three easy ways to get support: 

▪ Remote Conference 

▪ Email 

▪ Phone/Fax 

TIMS Medical 

a division of Foresight Imaging, LLC 

1 Executive Drive 

Suite 202 

Chelmsford, MA 01824 

Tel: (001) 978-458-4624 x204 

Fax: (001) 978-458-5488 

Email:  support@tims.com 

Web:  www.tims.com 
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